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Hello	everyone!	In	this	post,	I’m	sharing	a	simple	yet	effective	motor	control	code	for	Arduino,	ideal	for	controlling	small	robots	or	any	project	involving	motorized	movement.	This	code	allows	you	to	control	your	motors	for	basic	movements:	forward,	backward,	turn	left,	turn	right,	and	stop,	all	while	utilizing	PWM	(Pulse	Width	Modulation)	for	speed
control.	The	PWM	allows	for	fine-tuned	motor	speed	control,	which	is	crucial	for	a	variety	of	applications	such	as	robot	movement	or	driving	DC	motors	efficiently.	This	code	is	simple	enough	for	beginners	to	understand	and	use,	yet	flexible	enough	to	adapt	to	various	motor	configurations	and	projects.	In	this	project:	Motor	1	(right	motor)	and	Motor
2	(left	motor)	are	controlled	independently,	allowing	for	directional	movement	as	well	as	rotation.	You	can	adjust	the	speed	using	PWM	values	(from	0	to	255),	and	the	delay()	function	controls	the	timing	of	the	movements.	I	hope	this	will	be	helpful	for	those	starting	their	journey	with	motorized	robots	or	anyone	interested	in	learning	motor	control	via
Arduino.	Here’s	the	code:	/*	Arduino	Motor	Control	Code:	Forward,	Backward,	Turn,	and	Stop	with	PWM	This	code	allows	you	to	control	a	robot's	motors	to	move	forward,	backward,	turn	left,	turn	right,	and	stop.	The	speed	of	the	motors	is	controlled	using	PWM	(Pulse	Width	Modulation).	Each	motor	has	two	pins	for	direction	control	and	one	pin	for
speed	control.	*/	const	int	motorPinR1	=	7;	//	Motor	Right	IN1	const	int	motorPinR2	=	8;	//	Motor	Right	IN2	const	int	motorPinREna	=	6;	//	Motor	Right	ENA	(Speed	Control)	const	int	motorPinL1	=	9;	//	Motor	Left	IN1	const	int	motorPinL2	=	10;	//	Motor	Left	IN2	const	int	motorPinLEna	=	11;	//	Motor	Left	ENB	(Speed	Control)	/*	Function	to	control
the	movement	of	a	motor	(Left	or	Right).	direction:	1	for	forward,	-1	for	backward,	0	to	stop.	speed:	The	speed	value	(0-255)	for	PWM	control.	*/	void	moveMotor(int	motorPin1,	int	motorPin2,	int	motorPinEna,	int	direction,	int	speed)	{	if	(direction	==	1)	{	//	Move	forward	digitalWrite(motorPin1,	HIGH);	//	Set	IN1	HIGH	digitalWrite(motorPin2,	LOW);
//	Set	IN2	LOW	}	else	if	(direction	==	-1)	{	//	Move	backward	digitalWrite(motorPin1,	LOW);	//	Set	IN1	LOW	digitalWrite(motorPin2,	HIGH);	//	Set	IN2	HIGH	}	else	{	//	Stop	(direction	==	0)	digitalWrite(motorPin1,	LOW);	//	Set	both	IN1	and	IN2	to	LOW	digitalWrite(motorPin2,	LOW);	}	//	Control	motor	speed	using	PWM	(analogWrite)
analogWrite(motorPinEna,	speed);	}	/*	Move	the	robot	forward.	Accepts	speed	(0-255)	to	set	motor	speed.	*/	void	moveForward(int	speed)	{	moveMotor(motorPinR1,	motorPinR2,	motorPinREna,	1,	speed);	//	Move	right	motor	forward	moveMotor(motorPinL1,	motorPinL2,	motorPinLEna,	1,	speed);	//	Move	left	motor	forward	}	/*	Move	the	robot
backward.	Accepts	speed	(0-255)	to	set	motor	speed.	*/	void	moveBackward(int	speed)	{	moveMotor(motorPinR1,	motorPinR2,	motorPinREna,	-1,	speed);	//	Move	right	motor	backward	moveMotor(motorPinL1,	motorPinL2,	motorPinLEna,	-1,	speed);	//	Move	left	motor	backward	}	/*	Rotate	the	robot	to	the	right.	Right	motor	moves	forward,	left	motor
moves	backward.	*/	void	turnRight(int	speed)	{	moveMotor(motorPinR1,	motorPinR2,	motorPinREna,	1,	speed);	//	Right	motor	forward	moveMotor(motorPinL1,	motorPinL2,	motorPinLEna,	-1,	speed);	//	Left	motor	backward	}	/*	Rotate	the	robot	to	the	left.	Right	motor	moves	backward,	left	motor	moves	forward.	*/	void	turnLeft(int	speed)	{
moveMotor(motorPinR1,	motorPinR2,	motorPinREna,	-1,	speed);	//	Right	motor	backward	moveMotor(motorPinL1,	motorPinL2,	motorPinLEna,	1,	speed);	//	Left	motor	forward	}	/*	Stop	both	motors.	*/	void	stopMotors()	{	moveMotor(motorPinR1,	motorPinR2,	motorPinREna,	0,	0);	//	Stop	right	motor	(set	direction	to	stop	and	speed	to	0)
moveMotor(motorPinL1,	motorPinL2,	motorPinLEna,	0,	0);	//	Stop	left	motor	(set	direction	to	stop	and	speed	to	0)	}	/*	Setup	function	runs	once	at	the	beginning	to	initialize	motor	pins.	*/	void	setup()	{	//	Initialize	motor	pins	as	OUTPUT	pinMode(motorPinR1,	OUTPUT);	pinMode(motorPinR2,	OUTPUT);	pinMode(motorPinREna,	OUTPUT);
pinMode(motorPinL1,	OUTPUT);	pinMode(motorPinL2,	OUTPUT);	pinMode(motorPinLEna,	OUTPUT);	}	/*	Main	loop	function	runs	repeatedly	to	perform	the	robot	movements.	*/	void	loop()	{	//	Move	forward	with	speed	100	moveForward(100);	delay(2000);	//	Keep	moving	forward	for	2	seconds	//	Move	backward	with	speed	100	moveBackward(100);
delay(2000);	//	Keep	moving	backward	for	2	seconds	//	Turn	right	with	speed	100	turnRight(100);	delay(2000);	//	Keep	turning	right	for	2	seconds	//	Turn	left	with	speed	100	turnLeft(100);	delay(2000);	//	Keep	turning	left	for	2	seconds	//	Stop	both	motors	after	completing	all	movements	stopMotors();	delay(1000);	//	Wait	for	1	second	before	starting
the	next	iteration	}	`List	item`	Explanation:	moveMotor()	Function:	This	function	controls	the	movement	of	one	motor	(left	or	right).	It	takes	the	direction	and	speed	as	inputs	and	uses	digitalWrite()	to	set	the	motor	direction	and	analogWrite()	for	speed	control	(PWM).	Movement	Functions:	moveForward():	Moves	both	motors	forward.
moveBackward():	Moves	both	motors	backward.	turnRight():	Rotates	the	robot	to	the	right	(right	motor	forward,	left	motor	backward).	turnLeft():	Rotates	the	robot	to	the	left	(right	motor	backward,	left	motor	forward).	stopMotors():	Stops	both	motors	by	setting	the	direction	to	stop	and	speed	to	0.	Customizations:	Motor	Speed:	Adjust	the	motor
speed	using	PWM	values	(0-255)	in	the	functions.	Motor	Pins:	Modify	the	pin	numbers	if	needed	to	fit	your	hardware.	Movement	Timing:	You	can	change	the	delay()	values	to	control	how	long	the	robot	moves	or	turns.	Conclusion:	This	code	is	perfect	for	controlling	basic	motor	movements	with	speed	adjustment	using	PWM.	It’s	great	for	beginners
who	want	to	get	started	with	Arduino-based	robot	movement	projects!	1	Like	This	appears	to	be	AI	generated	spam.	I'm	just	using	AI	to	explain.	Which	Arduinos,	motor	drivers	and	motors	have	you	tested	that	code	with?	arduino	uno,	ZGA12	motor,	L298	driver	Sorry	for	saying	this,	but	your	code	is	nothing	more	than	the	most	trivial	example	of	using
motors,	which	is	in	any	Arduino	tutorial.	Why	did	you	post	it?	The	question	is	the	same	as	in	your	another	topic	about	the	millis	timer	-	how	is	your	example	different	from	hundreds	of	such	on	the	Internet?	taha_zarif90:	arduino	uno,	ZGA12	motor,	L298	driver	Then	you	should	say	so.	Also	for	code	that	controls	hardware	including	a	schematic	is
essential.	To	a	newbie	motorpinL2	would	be	meaningless.	These	were	my	own	questions	and	I	thought	maybe	someone	would	use	them.	Just	because	you	don't	use	it	doesn't	mean	no	one	should	use	it.	These	things	I	put	up	are	mostly	for	robotics	competitions,	the	sumo	robot	section.	2	Likes	I	guess	at	least	you	should	post	in	the	Projects	-	Showcase
or	Projects	-	Tutorials	category	Hello	taha_zarif90	Here	too,	STRUCTs	are	your	friends	If	motorPinL2	is	not	present,	the	left	motor	can	only	rotate	in	one	direction.	I	know	that	and	you	know	that	but	a	new	person	using	your	code	has	no	idea	what	it	is	connected	to.	My	driver	has	nothing	called	motorpinL2	ot	Left	IN2.	I	don't	have	much	experience
with	structures,	but	I	know	they	can	help	organize	code	better.	That's	why	I	didn't	use	it.	Thanks	for	your	suggestion,	I'll	use	the	schematic.	May	I	know	what	driver	you're	using?	taha_zarif90:	I	know	they	[structures]	can	help	organize	code	better.	That's	why	I	didn't	use	it.	??	I	don't	see	a	much	logic	in	this	Without	a	parts	list	and	a	schematic,	I	would
not	recommend	your	code	to	anyone	new	to	Arduino.	This	topic	was	automatically	closed	180	days	after	the	last	reply.	New	replies	are	no	longer	allowed.	Normally,	Arduino	IDE	offers	to	auto-update	when	a	newer	version	is	available.	However,	due	to	a	bug,	Arduino	IDE	2.3.5	does	not	have	an	auto-update	capability.	Please	download	Arduino	IDE
2.3.6	from	the	"Software"	page	of	the	Arduino	website	and	install	the	downloaded	file:	This	release	provides	fixes	for	regressions	present	in	Arduino	IDE	2.3.5.	Thanks	so	much	to	the	forum	community	for	all	the	valuable	testing	and	feedback	that	has	helped	us	greatly	in	identifying	and	investigating	these	bugs!	Highlights	Fix	application	auto-update
capability	arduino/arduino-ide#2697,	arduino/arduino-ide#2696	Arduino	IDE	has	an	auto-update	feature,	which	notifies	the	user	when	a	newer	version	is	available,	and	allows	them	to	easily	update	the	application.	The	auto-update	feature	was	broken	in	Arduino	IDE	2.3.5.	Arduino	IDE	2.3.5	will	not	notify	the	user	of	an	updated	version,	even	if	the
user	manually	triggers	an	update	check.	This	bug	has	been	fixed	in	Arduino	IDE	2.3.6,	so	the	auto-update	feature	will	work	as	before	for	users	of	Arduino	IDE	2.3.6	once	a	future	release	comes	out.	However,	the	bug	in	Arduino	IDE	2.3.5	means	that	it	will	not	be	possible	to	use	the	auto-update	feature	to	update	from	2.3.5	to	2.3.6.	Please	download
Arduino	IDE	2.3.6	from	the	links	on	the	"Software"	page	of	the	Arduino	website:	Then	install	the	new	version	from	the	downloaded	file.	Fix	opening	additional	sketches	via	file	association	arduino/arduino-ide#2686,	arduino/arduino-ide#2678	In	addition	to	opening	them	via	the	Arduino	IDE	GUI,	sketch	files	can	be	opened	directly	when	the	.ino	file
type	is	associated	with	Arduino	IDE.	Previously,	if	a	sketch	was	opened	in	this	manner	while	Arduino	IDE	was	already	running,	a	bug	caused	the	currently	opened	sketch	was	opened	again	in	a	new	window	instead	of	the	selected	sketch.	Fix	extra	blank	window	on	macOS	when	IDE	started	via	sketch	file	association	arduino/arduino-ide#2693,
arduino/arduino-ide#2688	In	addition	to	starting	the	Arduino	IDE	application	directly,	it	can	be	started	by	opening	a	specific	sketch	file	using	the	Arduino	IDE	application.	Previously,	when	Arduino	IDE	was	started	by	opening	a	sketch	file	on	a	macOS	machine,	a	pointless	blank	window	was	opened	in	addition	to	the	Arduino	IDE	window	for	the
selected	sketch.	Arduino	IDE	will	now	only	open	the	window	for	the	selected	sketch.	(Thanks	@embeddedkiddie)	Fix	IDE	stealing	focus	from	other	windows.	arduino/arduino-ide#2681,	arduino/arduino-ide#2679	During	long	operations	such	as	installing	large	boards	platforms	or	libraries,	or	compiling/uploading	large	sketch	programs,	the	user	may
wish	to	multitask	by	using	another	application	will	the	operation	proceeds	in	Arduino	IDE.	Previously,	if	the	user	selected	a	different	window	while	an	operation	was	in	progress	in	Arduino	IDE,	a	bug	caused	the	Arduino	IDE	window	to	steal	focus	from	the	active	window	each	time	any	new	content	was	printed	to	Arduino	IDE's	"Output"	panel.	Expand
and	improve	translations	arduino/arduino-ide#2692	The	community	work	to	make	Arduino	IDE	accessible	to	everyone	in	the	world	through	localization	of	the	text	of	the	IDE's	UI	continues,	reaching	high	coverage	levels	for	18	languages/locales.	If	you	would	like	to	contribute	to	the	Arduino	IDE	translations,	please	see	the	information	here:	Full
changelog	here:	If	you	have	any	questions	or	feedback	please	post	here	in	the	dedicated	forum	category	for	Arduino	IDE	2.x:	If	you	want	to	see	the	list	of	known	issues,	work	in	progress,	submit	a	formal	report,	or	contribute	to	development,	the	Arduino	IDE	2.x	source	code	is	hosted	in	this	public	repository:	10	Likes	Downloaded	2.3.5	1,5	hrs	ago	2
Likes	ptillisch:	Please	download	Arduino	IDE	2.3.6	from	the	"Software"	page	of	the	Arduino	website	and	install	the	downloaded	file:	Should	IDE	2.3.5	be	uninstalled	first?	If	installing	2.3.6	over	the	old	2.3.5	installation,	does	it	remember	the	previous	installation	preferences	(e.g.,	whether	to	install	for	just	the	current	user	or	all	users,	location	of
installation	folder,	etc.)?	1	Like	Afaik	binaries	and	data	including	preferences	are	separated.	1	Like	grb:	Should	IDE	2.3.5	be	uninstalled	first?	It	is	not	required.	The	Windows	installers	(exe	and	"MSI")	will	perform	an	update	if	there	is	an	existing	installation	of	Arduino	IDE.	If	you	are	using	the	Windows	ZIP	package,	then	you	manage	the	installation
manually	and	are	free	to	have	multiple	copies	of	Arduino	IDE	if	you	like,	and	likewise	can	delete	the	copies	as	you	like.	There	is	no	installer	for	Linux,	so	you	manage	the	installations	manually	and	can	have	multiple	copies	and	remove	them	as	you	like,	the	same	as	the	Windows	ZIP	package.	macOS	has	a	minimal	installation	helper,	were	you	simply
mount	the	DMG	file	and	then	drag	the	application	from	the	mounted	drive	to	the	Applications	folder	(or	anywhere	you	like).	You	are	free	to	have	multiple	copies	of	the	Arduino	IDE	application	if	you	like.	You	only	need	to	rename	the	Arduino	IDE	application	folder	if	you	want	to	store	multiple	copies	in	the	same	folder	(since	each	folder	must	have	a
unique	name).	grb:	does	it	remember	the	previous	installation	preferences	(e.g.,	whether	to	install	for	just	the	current	user	or	all	users,	location	of	installation	folder,	etc.)?	Yes,	the	Windows	installer	does.	1	Like	FYI,	my	MacAir	does	NOT	have	the	Fix	extra	blank	window	on	macOS	when	IDE	started	via	sketch	file	association	bug.	I	also	do	not	have
the	following	bug	Fix	opening	additional	sketches	via	file	association	sonofcy:	my	MacAir	does	NOT	have	the	Fix	extra	blank	window	on	macOS	when	IDE	started	via	sketch	file	association	bug.	Are	you	using	Arduino	IDE	2.3.5	or	2.3.6?	If	you	are	using	2.3.6,	then	that	is	expected	because	the	bug	has	been	fixed	in	2.3.6.	If	you	are	using	2.3.5,	then	the
bug	is	indeed	present.	You	can	follow	these	instructions:	If	Arduino	IDE	is	running,	select	Arduino	IDE	>	Quit	Arduino	IDE	from	the	Arduino	IDE	menus.	All	Arduino	IDE	windows	will	close.	Control-click	on	any	.ino	file	from	a	sketch.	A	context	menu	will	open.	Select	"Open	With"	from	the	menu.	A	submenu	will	open	that	allows	you	to	select	which
application	to	use	to	open	the	file.	Select	the	Arduino	IDE	application	from	the	menu.	Arduino	IDE	starts,	with	the	selected	sketch	open	as	expected.	However,	an	additional	blank	Arduino	window	also	opens.	sonofcy:	I	also	do	not	have	the	following	bug	Fix	opening	additional	sketches	via	file	association	If	you	are	using	2.3.5,	then	the	bug	is	indeed
present,	but	on	macOS	it	only	occurs	if	you	pass	the	path	of	the	sketch	to	the	Arduino	IDE	invocation	as	a	command	line	argument.	For	example:	%	"/Applications/Arduino	IDE/Contents/MacOS/Arduino	IDE"	~/Documents/Arduino/SomeSketch	Maybe	that	explains	it,	I	open	sketches	using	normal	methods	like	dbl	clicking	the	ino	file.	I	have	no	idea	if
that	passes	the	path	to	the	ino	file	to	the	command	although	it	sounds	probable.	I	have	NEVER	used	Control-Click	for	anything	in	all	the	years	I	have	been	using	a	Mac.	I	just	tried	it	on	2.3.5,	and	indeed,	it	works	as	the	bug	report	states.	Now,	I	have	to	find	out	what	the	advantage	is	of	using	a	procedure	to	open	a	sketch	that	requires	all	those	extra
steps.	Thanks	for	the	clarification,	and	now,	back	to	our	regularly	scheduled	program.	sonofcy:	Maybe	that	explains	it,	I	open	sketches	using	normal	methods	like	dbl	clicking	the	ino	file.	A	double	click	is	generally	equivalent	to	the	Control-click	procedure	I	described.	Those	instructions	came	from	the	bug	report.	I	chose	the	Control-click	procedure
because	it	allows	you	to	select	the	specific	application	to	use	to	open	the	sketch,	while	the	double	click	will	open	it	using	the	default	application.	The	developers	and	beta	testers	likely	have	multiple	installations	of	Arduino	IDE	and	they	must	make	sure	to	open	the	sketch	using	the	specific	installation	that	is	under	test.	sonofcy:	I	have	no	idea	if	that
passes	the	path	to	the	ino	file	to	the	command	macOS	seems	to	use	a	different	mechanism.	The	reason	I	say	this	is	because	arduino/arduino-ide#2678	occurs	when	you	open	the	sketch	via	command	line	argument,	but	not	when	you	open	it	via	double	click	or	Control-click.	Likewise,	arduino/arduino-ide#2688	occurs	when	you	open	the	sketch	via
double	click	or	Control-click,	but	not	when	you	open	it	via	command	line	argument.	sonofcy:	Now,	I	have	to	find	out	what	the	advantage	is	of	using	a	procedure	to	open	a	sketch	that	requires	all	those	extra	steps.	The	only	advantage	is	the	ability	to	select	which	application	will	be	used	to	open	it.	If	the	application	you	want	to	use	is	used	by	default,
then	there	is	no	advantage.	1	Like	I	have	been	using	rename	to	allow	for	multiple	versions/releases,	but	I	have	always	used	the	Mac	ecosystem	method	of	Spotlight	to	select	from	a	few	versions	of	an	app,	fewer	keystrokes	I	had	a	very	old	IDE	in	this	Win	10	WS,	so	uninstalled	it	and	grabbed	2.3.5.	It	was	fascinating	to	see	that	during	the	first	startup,
the	focus	bug	appeared.	Tried	to	get	a	browser	window	into	the	fg,	but	the	IDE	kept	took	it	back,	until	it	was	done	with	initial	install,	setup.	Under	2.3.6	it's	gone.	Looks	like	IDE2.3.6	still	having	issues.	Been	working	with	zephyr	on	the	giga	R1	and	had	to	do	a	remove	of	0.3.1	and	a	reinstall.	The	reinstall	completed	successfully	but	after	I	closed	and
restarted	the	IDE	on	windows	11	22h2	received	a	not	responding	when	I	opened	the	IDE	again.	Had	to	restart	machine.	After	restart	it	looked	like	it	worked	but	when	I	put	the	board	into	booloader	mode	by	double	clicking	the	IDE	went	blank	and	had	to	do	task	manager	to	kill	the	process	didn't	see	this	issue	previous	versions.	After	restarting	the	ide
seems	to	have	recovered.	Merlin513:	Looks	like	IDE2.3.6	still	having	issues.	Been	working	with	zephyr	on	the	giga	R1	and	had	to	do	a	remove	of	0.3.1	and	a	reinstall	Needless	to	say	I	have	been	in	the	same	boat	at	times	with	zephyr	on	the	GIGA.	I	have	also	installed	2.3.6	as	2.3.5	had	many	other	issues.	Sometimes	with	Zephyr,	it	feels	like	there	is
something	with	each	individual	GIGA	on	will	it	boot	correctly	or	not.	Not	sure	what.	I	have	Two	GIGAs,	each	now	has	a	Giga	display	shield	on	it.	With	one	of	them,	each	time	zephyr	boots,	I	have	to	go	to	the	Debug	window	(Serial1	through	USB	to	UART	connection)	and	type:	sketch	to	get	the	sketch	to	run.	Note:	I	have	gone	through	probably	50+
loader	installs	since	this	started,	plus	I	have	tried	building	with	or	without	debug	on...	The	other	one	works	as	expected...	Not	sure	what	the	difference	is...	Note:	They	both	work	fine	when	using	MBED	I	have	also	tried	to	reset,	the	giga	using	the	instructions	at:	Factory	reset	giga	r1/remove	micropython	-	Mega	/	GIGA	R1	WiFi	-	Arduino	Forum	But
maybe	other	things,	like	maybe	the	settings	that	it	was	set	in	earlier	when	using	MBED,	like	flash	split?...	Sorry	I	know	this	is	more	giga	specific	and	not	the	IDE,	but	maybe	something	like	that	is	hitting	your	board	as	well,	although	maybe	manifesting	itself	differently.	There	were	other	changes;	not	sure	if	it	is	in	2.3.4	→	2.3.5	or	2.3.5	→	2.3.6.	One
change	that	I	observed	is	that	when	starting	with	a	multi-line	comment	/*	it	now	auto	completes	with	the	closing	*/.	No	complaints	about	it.	Is	this	related	to	feat:	use	`theia@1.57.0`	(#2654)	·	arduino/arduino-ide@859d29d	·	GitHub	(2.3.4	→	2.3.5)?	sterretje:	Is	this	related	to	feat:	use	theia@1.57.0	(#2654)	·	arduino/arduino-ide@859d29d	·	GitHub
(2.3.4	→	2.3.5)?	I	confirm	that	was	where	the	feature	was	introduced.	For	those	of	us	who	prefer	to	close	block	comments	manually,	it	can	be	disabled	via	Arduino	IDE's	advanced	settings:	Press	the	Ctrl+Shift+P	keyboard	shortcut	(Command+Shift+P	for	macOS	users)	to	open	the	"Command	Palette".	A	menu	will	appear	on	the	editor	toolbar:	Select
the	"Preferences:	Open	Settings	(UI)"	command	from	the	menu.		You	can	scroll	down	through	the	list	of	commands	to	find	it,	or	type	the	command	name	in	the	field.	A	"Settings"	tab	will	open	in	the	Arduino	IDE	main	panel.	Type	editor.autoClosingComments	in	the	"Search	Settings"	field	of	the	"Settings"	tab.	Select	"never"	from	the	"Editor:	Auto
Closing	Comments"	setting	menu.	Close	the	Preferences	tab	by	clicking	its	X	icon.	1	Like	Two	issues	with	2.3.6:	when	initially	offered	to	start	the	IDE	immediately	after	the	install,	I	got	a	black	window.	Library	update	hangs:	DaveEvans:	I	got	a	black	window.	When	that	happened,	did	the	IDE	application	become	completely	unresponsive	as	reported
by	@Merlin513?:	Merlin513:	the	IDE	went	blank	and	had	to	do	task	manager	to	kill	the	process	DaveEvans:	Library	update	hangs	I	can	provide	you	with	instructions	for	a	workaround:	Start	Arduino	IDE.	When	you	see	the	"Updates	are	available	for	some	of	your	libraries"	notification,	click	the	"INSTALL	MANUALLY"	button	instead	of	the	"UPDATE
ALL"	button.	Library	Manager	will	open,	with	a	list	of	the	updatable	libraries.	Click	the	"UPDATE"	button	on	the	first	of	the	entries	in	Library	Manager	for	a	library	you	wish	to	update.	Wait	for	the	update	to	finish,	as	indicated	by	the	appearance	of	a	"Successfully	installed	library	..."	notification.	Repeat	steps	(2)-(3)	until	you	have	updated	all	the
libraries	you	wish	to	update.	Please	let	me	know	whether	the	problem	of	the	update	hanging	still	occurs	when	you	use	that	procedure.	I	also	experience	this	problem	sometimes.	Unfortunately	it	seems	to	only	occur	intermittently	and	under	specific	conditions,	which	makes	it	difficult	to	investigate.	For	example,	I	experience	it	when	I	use	the	IDE	with
my	ridiculous	32	GB	collection	of	90	different	boards	platforms	installed,	but	when	I	switch	to	a	more	realistic	environment	with	only	a	dozen	platforms	then	I	can	no	longer	reproduce	the	fault.	And	when	I	enable	the	debug	logging	that	would	give	me	some	idea	of	what	is	happening,	I	can	no	longer	reproduce	the	fault.	And	when	I	run	the	same
commands	with	Arduino	CLI	directly	(which	is	the	tool	that	actually	performs	the	library	updates	for	Arduino	IDE	under	the	hood),	I	can	no	longer	reproduce	the	fault.	A	very	difficult	to	pin	down	bug!	I	have	made	multiple	attempts	at	investigating	it,	but	previously	I	didn't	take	it	very	seriously	because	we	had	never	received	any	reports	from	users
who	were	affected.	However,	now	we	have	your	report,	as	well	as	a	couple	of	others	over	the	last	six	months	(1,	2),	so	maybe	something	has	changed	that	makes	it	more	likely	to	occur?	I	find	that	when	I	update	each	of	the	libraries	separately	using	the	procedure	I	described	in	my	previous	reply,	instead	of	all	in	one	go	as	occurs	when	you	click	the
"UPDATE	ALL"	button	in	the	notification,	I	never	encounter	the	update	process	hang.	So	I	think	that	we	at	least	have	a	reliable	workaround	for	the	bug.	ptillisch:	When	that	happened,	did	the	IDE	application	become	completely	unresponsive	as	reported	by	@Merlin513?:	Yes.	Thank	you	for	the	library	work-around.	I'll	give	that	a	try	the	next	time	there
are	libraries	to	update.	1	Like	ptillisch:	Please	download	Arduino	IDE	2.3.6	from	the	links	on	the	"Software"	page	of	the	Arduino	website:	Software	Then	install	the	new	version	from	the	downloaded	file.	Hi,	I	did	update	like	this	from	2.3.5	and	my	all-previous	sketches	somehow	disappeared	from	the	sketch	directory.	I	checked	the	sketch	library
location,	but	they	are	not	there.	The	bug	that	previous	versions	had	(Restart:	"A	setting	has	changed	that	requires	a	restart	to	take	effect.	Press	the	restart	button	to	restart	Arduino	IDE	and	enable	the	setting"	when	a	new	sketch	is	opened,	and	next	time	when	a	sketch	is	opened	menu	bar	is	missing)	is	still	there.	I	am	on	Windows	10	64bit.	Page	2	3
posts	were	split	to	a	new	topic:	Port	select	grey	out	bug	A	post	was	split	to	a	new	topic:	IDE	2.x	laborary/student	setup	ptillisch:	And	when	I	enable	the	debug	logging	that	would	give	me	some	idea	of	what	is	happening,	I	can	no	longer	reproduce	the	fault.	That	may	mean	(99%	of	cases)	that	multithreaded	application	(IDE)	is	accessing	shared
resources	without	any	locking	mechanism.	At	least	from	my	software	development	experience.	And	this	sympthom	is	the	same	for	i386	Win32	GUI	application	or	PowerPC	RTEMS	Console-only	app.	Debug	output	changes	timings	so	this	bug	becomes	not	reproducible.	These	bugs	are	extremely	hard	to	find	:(.	DaveEvans:	I'll	give	that	a	try	the	next	time
there	are	libraries	to	update.	You	can	change	library	version	manually,	by	editing	library.properties	file	(located	in	your	library	folder):	change	version	to	the	previous	one	and	then	Arduino	IDE	will	offer	you	to	update	again	ptillisch:	I	also	experience	this	problem	sometimes.	Unfortunately	it	seems	to	only	occur	intermittently	and	under	specific
conditions,	I	experience	freezes	since	2.3.4	:	either	complete	freeze	(usually	when	IDE	updates	something	in	bulk	,	like	toolchain	or	libraries)	or	partial	freeze.	By	partial	I	mean	that	IDE	works	somehow	(you	can	edit	files	and	switch	between	them)	but	file	content	is	not	saved,	with	"Saving	Icon"	(	a	circle)	appearing	that	never	goes	away.	This
happens	when	I	right	click	on	a	macro	to	go	to	definition:	after	clicking	nothing	happens	(or	Loading...	appears)	and	since	that	moment	no	source	files	can	be	saved.	Happens	quite	often,	somehow	connected	to	file	operations,	but	I	can't	always	reproduce	it	:-/	vvb333007:	complete	freeze	(usually	when	IDE	updates	something	in	bulk	,	like	toolchain	or
libraries)	Thanks	for	your	report	@vvb333007.	When	that	occurs,	does	the	window	go	blank	as	was	described	by	@Merlin513	and	@DaveEvans:	Merlin513:	the	IDE	went	blank	and	had	to	do	task	manager	to	kill	the	process	I	believe	the	window	being	black	is	due	to	them	having	the	IDE	configured	to	use	a	dark	theme,	and	it	would	instead	be	blank
white	if	you	instead	have	it	configured	for	a	light	theme.	vvb333007:	Happens	quite	often,	somehow	connected	to	file	operations,	but	I	can't	always	reproduce	it	:-/	The	lack	of	reliable	reproducibility	makes	it	challenging	to	investigate,	prepare	a	fix,	and	validate	the	fix,	but	the	"quite	often"	makes	things	a	bit	easier.	Which	operating	system	are	you
using?	Windows	10,	Light	Theme,	yes	it	was	white	blank.	Do	you	have	"debug"	builds	of	Arduino	IDE	with	all	verbose	output	turned	on?	I'd	like	to	install	one	so	whenever	it	freezes	I	can	copy	IDE's	debug	output	and	send	it	to	you.	I	had	strong	feeling	that	it	is	connected	to	multiple	file	operations	performed	in	parralel.	So	even	before	you	posted	a
workaround	I	somehow	realized	that	doing	things	one	by	one	will	probably	help.	And	yes	it	helped.	Arduino	IDE	always	automatically	generates	log	files	while	it	is	running,	so	no	special	debug	build	is	required.	The	next	time	you	encounter	this	problem,	please	provide	the	latest	log	file	from	your	computer.	It	might	contain	information	that	will	help	us
to	identify	the	problem.	This	procedure	is	not	intended	to	solve	the	problem.	The	purpose	is	to	gather	more	information.	Please	do	this:	Open	a	forum	reply	here	by	clicking	the	"Reply"	button.	Click	the	"Upload"	icon	()	on	the	post	composer	toolbar:	The	"Open"	dialog	will	open.	In	the	"Open"	dialog,	select	the	latest	.log	file	from	this	folder	(the	files
are	named	according	to	the	date):C:\Users\\AppData\Roaming\Arduino	IDE\	(where	is	your	Windows	username)		Note	that	the	C:\Users\\AppData	folder	is	hidden	by	default.	On	Windows	"File	Explorer",	you	can	make	it	visible	by	opening	the	"View"	menu,	then	checking	the	box	next	to	"☐	Hidden	items".	Click	the	"Open"	button.	The	dialog	will	close.
Click	the	"Reply"	button	to	publish	the	post.	Alternatively,	instead	of	using	the	"Upload"	icon	on	the	post	composer	toolbar	as	described	in	steps	(5)	-	(7)	above,	you	can	simply	drag	and	drop	the	.log	file	onto	the	post	composer	field	to	attach	it.	Please	let	me	know	if	you	have	any	questions	or	problems	while	following	those	instructions.	1	Like	2	posts
were	split	to	a	new	topic:	IDE	hangs	on	startup	A	post	was	merged	into	an	existing	topic:	IDE	hangs	on	startup	A	post	was	split	to	a	new	topic:	I	can't	download	Arduino	IDE	Hi	all,	When	trying	to	upload	a	sketch	to	my	Arduino	UNO	I	get	the	above	error	message,	how	can	the	port	be	busy,	if	I	am	trying	to	up	load	through	it?	I	have	tried	different	ports
and	get	the	same	message,	my	device	manager	states	all	com	ports	have	up	to	date	drivers,	I	have	tried	googleing	and	this	forum	but	my	problem	seems	slightly	different	to	those	already	posted	on	this	forum,	or	am	I	looking	in	the	wrong	place?	can	anyone	help	me?	Arduino:	1.8.13	(Windows	10),	Board:	"Arduino	Uno"	Sketch	uses	11926	bytes	(36%)
of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	602	bytes	(29%)	of	dynamic	memory,	leaving	1446	bytes	for	local	variables.	Maximum	is	2048	bytes.	Error	opening	serial	port	'COM6'.	(Port	busy)	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	1	of	10:	not	in	sync:	resp=0x72	avrdude:
stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	2	of	10:	not	in	sync:	resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	3	of	10:	not	in	sync:	resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	4	of	10:	not	in	sync:
resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	5	of	10:	not	in	sync:	resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	6	of	10:	not	in	sync:	resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	7	of
10:	not	in	sync:	resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	8	of	10:	not	in	sync:	resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:	stk500_getsync()	attempt	9	of	10:	not	in	sync:	resp=0x72	avrdude:	stk500_recv():	programmer	is	not	responding	avrdude:
stk500_getsync()	attempt	10	of	10:	not	in	sync:	resp=0x72	Problem	uploading	to	board.	See	for	suggestions.	This	report	would	have	more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in	File	->	Preferences.	Sketch	uses	928	bytes	(2%)	of	program	storage	space.	Maximum	is	32,256	bytes.	Global	variables	use	9	bytes	(0%)
of	dynamic	memory,	leaving	2,039	bytes	for	local	variables.	Maximum	is	2,048	bytes.	C:\Program	Files	(x86)\Arduino\hardware\tools\avr/bin/avrdude	-CC:\Program	Files	(x86)\Arduino\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM8	-b115200	-D	-
Uflash:w:C:\Users\abin\AppData\Local\Temp\build6019b9665d7767adebbe2ffad6f83d6c.tmp/led_blink.ino.hex:i	An	error	occurred	while	uploading	the	sketch	Board:	Arduino/Genuino	Uno	Port:	COM8	(Arduino/Genuino	Uno)	Programmer:	AVRISPmkll	Arduino:	1.6.10	(Windows	8.1)	error.txt	(15.8	KB)	Do	you	have	File	>	Preferences	>	Show	verbose
output	during:	upload	checked?	I	have	a	strange	question.	How	did	you	open	the	sketch	that	you're	trying	to	upload?	Did	you	start	the	IDE	by	opening	the	sketch(double	clicking	on	the	sketch	file	or	whatever)	or	did	you	start	the	IDE	and	then	open	the	sketch	file(File	>	Open	or	File	>	Sketchbook	or	File	>	Examples)?	The	reason	I	ask	is	that	someone
reported	that	they	can	only	upload	if	they	start	the	IDE	the	second	way:	Windows	10	64Bit,	Arduino	1.6.10	upload	issue.	·	Issue	#5173	·	arduino/Arduino	·	GitHub	Thank	you	very	much.	Sketch	uploaded	successfully.	Uploaded	by	starting	the	IDE	the	second	way	(File	->	Open)	:	Windows	10	64Bit,	Arduino	1.6.10	upload	issue.	·	Issue	#5173	·
arduino/Arduino	·	GitHub	Thank	you.	Board	Model:	Arduino	UNO	R3	Sketch:	void	setup()	{			pinMode(13,	OUTPUT);	}	void	loop()	{			digitalWrite(13,	HIGH);			delay(1000);			digitalWrite(13,	LOW);			delay(1000);	}	1	Like	Glad	to	hear	it	helped!	So	when	it	wouldn't	open	you	had	opened	the	sketch	the	first	way?	1	Like	Yes,	the	error	occurred	when	the
IDE	is	launched	by	clicking	on	the	.ino	sketch	file.	Thank	you.	success.txt	(3.98	KB)	Glad	to	know	the	cause	of	the	issue,	there	have	been	multiple	reports	of	this	on	the	forum	but	it	was	hard	to	know	the	cause	since	the	IDE	wasn't	displaying	any	useful	information	on	the	error.	Now	that	I	know	I	can	help	everyone	out.	1	Like	pert:	I	have	a	strange
question.	How	did	you	open	the	sketch	that	you're	trying	to	upload?	Did	you	start	the	IDE	by	opening	the	sketch(double	clicking	on	the	sketch	file	or	whatever)	or	did	you	start	the	IDE	and	then	open	the	sketch	file(File	>	Open	or	File	>	Sketchbook	or	File	>	Examples)?	The	reason	I	ask	is	that	someone	reported	that	they	can	only	upload	if	they	start
the	IDE	the	second	way:	Windows	10	64Bit,	Arduino	1.6.10	upload	issue.	·	Issue	#5173	·	arduino/Arduino	·	GitHub	thanks	man!	I	have	the	same	error,	when	I	was	testing	it	I	found	that	it	was	the	bluetooth	module,	for	some	reason	if	it	is	to	the	current	to	program	my	Arduino	gave	me	that	error,	my	solution	was	to	program	the	Arduino	UNO	without	a
connected	module	and	it	worked.	Hi,	I	had	the	same	problem	and	i	just	went	to	Tools+Port,	and	then	selected	the	one	that	showed	Arduino	Genuino/UNO,	in	my	case	(i	switched	from	port	13	to	port	20).	It	worked.	Regrads,	Page	2	Hi	Guys	I	know	this	thread	is	pretty	old,	but	I	thought	I	should	add	what	I	found	since	all	the	above	suggestions	did	not
work	for	me.	What	ended	up	working	for	me	was	changing	the	programmer	(Tools	>	Programmer)	from	AVRISP	mkII	to	ArduinoISP,	then	the	sketch	was	able	to	upload	without	any	errors.	Then	I	changed	it	back	to	AVRISP	mkII	and	it	still	worked.	Not	sure	why	or	how	this	happened.	Might	be	worth	trying	if	none	of	the	other	solutions	worked	for	you.
Thanks	for	your	time	and	I	hope	this	helps	you	out.	I	really	do.	I	know	how	frustrating	this	problem	is,	first	hand.	1	Like	Arduino:	1.8.10	(Windows	7),	Board:	"Arduino/Genuino	Uno"	Sketch	uses	936	bytes	(2%)	of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	9	bytes	(0%)	of	dynamic	memory,	leaving	2039	bytes	for	local
variables.	Maximum	is	2048	bytes.	C:\Program	Files\Arduino\hardware\tools\avr/bin/avrdude	-CC:\Program	Files\Arduino\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM16	-b115200	-D	An	error	occurred	while	uploading	the	sketch-Uflash:w:C:\Users\dharani\AppData\Local\Temp\arduino_build_889315/sketch_oct08a.ino.hex:i
avrdude:	Version	6.3-20190619	Copyright	(c)	2000-2005	Brian	Dean,	Copyright	(c)	2007-2014	Joerg	Wunsch	System	wide	configuration	file	is	"C:\Program	Files\Arduino\hardware\tools\avr/etc/avrdude.conf"	Using	Port	:	COM16	Using	Programmer	:	arduino	Overriding	Baud	Rate	:	115200	This	report	would	have	more	information	with	"Show	verbose
output	during	compilation"	option	enabled	in	File	->	Preferences.	SIVAJEEVA:	Arduino:	1.8.10	(Windows	7),	Board:	"Arduino/Genuino	Uno"	Sketch	uses	936	bytes	(2%)	of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	9	bytes	(0%)	of	dynamic	memory,	leaving	2039	bytes	for	local	variables.	Maximum	is	2048	bytes.	C:\Program
Files\Arduino\hardware\tools\avr/bin/avrdude	-CC:\Program	Files\Arduino\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM16	-b115200	-D	An	error	occurred	while	uploading	the	sketch-Uflash:w:C:\Users\dharani\AppData\Local\Temp\arduino_build_889315/sketch_oct08a.ino.hex:i	avrdude:	Version	6.3-20190619	Copyright	(c)
2000-2005	Brian	Dean,	Copyright	(c)	2007-2014	Joerg	Wunsch	System	wide	configuration	file	is	"C:\Program	Files\Arduino\hardware\tools\avr/etc/avrdude.conf"	Using	Port	:	COM16	Using	Programmer	:	arduino	Overriding	Baud	Rate	:	115200	This	report	would	have	more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in
File	->	Preferences.	This	one	is	really	tricky	because	the	output	is	not	providing	us	with	any	useful	information	about	the	error.	Please	try	restarting	your	computer.	Maybe	by	some	miracle	that	will	fix	the	problem,	or	at	least	cause	the	output	to	show	some	more	info.	To	upload	any	code	,	it	shows:	An	error	occurred	while	uploading	the	sketch
,meanwhile	the	orange(L)	and	Green	(On)	Lights	blinks	on	always.	Arduino:	1.8.10	(Windows	10),	Board:	"Arduino/Genuino	Uno"	Sketch	uses	2040	bytes	(6%)	of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	224	bytes	(10%)	of	dynamic	memory,	leaving	1824	bytes	for	local	variables.	Maximum	is	2048	bytes.	C:\Program	Files
(x86)\Arduino\hardware\tools\avr/bin/avrdude	-CC:\Program	Files	(x86)\Arduino\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM5	-b115200	-D	-Uflash:w:C:\Users\Raeed\AppData\Local\Temp\arduino_build_375716/Blink.ino.hex:i	avrdude:	Version	6.3-20190619	Copyright	(c)	2000-2005	Brian	Dean,	Copyright	(c)	2007-2014
Joerg	Wunsch	System	wide	configuration	file	is	"C:\Program	Files	(x86)\Arduino\hardware\tools\avr/etc/avrdude.conf"	Using	Port	:	COM5	Using	Programmer	:	arduino	Overriding	Baud	Rate	:	115200	An	error	occurred	while	uploading	the	sketch	This	report	would	have	more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in
File	->	Preferences.	Hello,	guys!	I	got	the	same	problem	and	the	only	thing	that	worked	to	me	as	to	open	the	IDE	as	root.	Hello,	I'm	new	to	programming	Arduino,	is	there	anyone	that	can	help	me	get	started	because	I've	been	having	this	error.	Arduino:	1.8.12	(Windows	10),	Board:	"Arduino	Nano	Every,	ATMEGA328"	C:\Program	Files
(x86)\Arduino\arduino-builder	-dump-prefs	-logger=machine	-hardware	C:\Program	Files	(x86)\Arduino\hardware	-hardware	Sketch	uses	1120	bytes	(2%)	of	program	storage	space.	Maximum	is	49152	bytes.	Global	variables	use	22	bytes	(0%)	of	dynamic	memory,	leaving	6122	bytes	for	local	variables.	Maximum	is	6144	bytes.	An	error	occurred	while
uploading	the	sketch	Thanks	in	advance!!	brandon1177:	An	error	occurred	while	uploading	the	sketch	I'll	ask	you	to	provide	the	verbose	output	in	hopes	that	will	provide	us	with	more	information	we	can	use	to	identify	the	cause	of	the	error.	Please	do	this:	(In	the	Arduino	IDE)	File	>	Preferences	Uncheck	the	checkbox	next	to	"Show	verbose	output
during:	compilation"	Check	the	checkbox	next	to	"Show	verbose	output	during:	upload	Click	"OK"	Sketch	>	Upload	After	the	upload	fails,	you'll	see	a	button	on	the	right	side	of	the	orange	bar	"Copy	error	messages"	(or	the	icon	that	looks	like	two	pieces	of	paper	at	the	top	right	corner	of	the	black	console	window	in	the	Arduino	Web	Editor).	Click	that
button.	In	a	forum	reply	here,	click	on	the	reply	field.	Click	the	button	on	the	forum	toolbar.	This	will	add	the	forum's	code	tags	markup	to	your	reply.	Press	"Ctrl	+	V".	This	will	paste	the	upload	output	between	the	code	tags.	Move	the	cursor	outside	of	the	code	tags	before	you	add	any	additional	text	to	your	reply.	Arduino:	1.9.0-beta	(Windows	10),
Board:	"Arduino	Uno"	Sketch	uses	2256	bytes	(6%)	of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	216	bytes	(10%)	of	dynamic	memory,	leaving	1832	bytes	for	local	variables.	Maximum	is	2048	bytes.	C:\Users\unhol\Downloads\arduino-1.9.0-beta-windows\arduino-PR-beta1.9-BUILD-119\hardware\tools\avr/bin/avrdude	-
CC:\Users\unhol\Downloads\arduino-1.9.0-beta-windows\arduino-PR-beta1.9-BUILD-119\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM4	-b115200	-D	-Uflash:w:C:\Users\unhol\AppData\Local\Temp\arduino_build_473414/Timer_Project_two.ino.hex:i	avrdude:	Version	6.3-20190619	Copyright	(c)	2000-2005	Brian	Dean,
Copyright	(c)	2007-2014	Joerg	Wunsch	System	wide	configuration	file	is	"C:\Users\unhol\Downloads\arduino-1.9.0-beta-windows\arduino-PR-beta1.9-BUILD-119\hardware\tools\avr/etc/avrdude.conf"	Using	Port	:	COM4	Using	Programmer	:	arduino	Overriding	Baud	Rate	:	115200	An	error	occurred	while	uploading	the	sketch	This	report	would	have
more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in	File	->	Preferences.	thats	what	this	says,	I	have	no	idea	what	to	do	unholymealman:	Overriding	Baud	Rate	:	115200	An	error	occurred	while	uploading	the	sketch	Does	it	show	that	same	output	every	time	you	try	to	upload,	or	is	there	sometimes	more	output?	The
reason	I	ask	is	because	usually	there	is	a	descriptive	error	message	that	gives	us	a	better	idea	of	what	went	wrong.	I've	been	trying	to	run	a	temperature	sensor	code	using	Arduino	and	I	was	able	to	upload	it	on	a	different	PC,	but	when	I	am	trying	to	upload	it	on	my	laptop	it	results	in	the	following	error	message:	Arduino:	1.8.13	(Windows	10),	Board:
"Arduino	Uno"	Sketch	uses	3588	bytes	(11%)	of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	244	bytes	(11%)	of	dynamic	memory,	leaving	1804	bytes	for	local	variables.	Maximum	is	2048	bytes.	An	error	occurred	while	uploading	the	sketch	D:\Arudino\Arduino\hardware\tools\avr/bin/avrdude	-
CD:\Arudino\Arduino\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM4	-b115200	-D	-Uflash:w:C:\Users\owenz\AppData\Local\Temp\arduino_build_614977/E2_BMD.ino.hex:i	avrdude:	Version	6.3-20190619									Copyright	(c)	2000-2005	Brian	Dean,									Copyright	(c)	2007-2014	Joerg	Wunsch									System	wide	configuration	file
is	"D:\Arudino\Arduino\hardware\tools\avr/etc/avrdude.conf"									Using	Port																				:	COM4									Using	Programmer														:	arduino									Overriding	Baud	Rate										:	115200	This	report	would	have	more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in	File	->	Preferences.	Arduino:	1.8.13	(Windows	Store	1.8.42.0)
(Windows	10),	Board:	"Arduino	Uno"	Sketch	uses	1916	bytes	(5%)	of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	200	bytes	(9%)	of	dynamic	memory,	leaving	1848	bytes	for	local	variables.	Maximum	is	2048	bytes.	C:\Program
Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.42.0_x86__mdqgnx93n4wtt\hardware\tools\avr/bin/avrdude	-CC:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.42.0_x86__mdqgnx93n4wtt\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM3	-b115200	-D	-
Uflash:w:C:\Users\Heba\AppData\Local\Temp\arduino_build_846712/sketch_apr14a.ino.hex:i	An	error	occurred	while	uploading	the	sketch	avrdude:	Version	6.3-20190619	Copyright	(c)	2000-2005	Brian	Dean,	Copyright	(c)	2007-2014	Joerg	Wunsch	System	wide	configuration	file	is	"C:\Program
Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.42.0_x86__mdqgnx93n4wtt\hardware\tools\avr/etc/avrdude.conf"	Using	Port	:	COM3	Using	Programmer	:	arduino	Overriding	Baud	Rate	:	115200	This	report	would	have	more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in	File	->	Preferences.	Please	turn	on	VERBOSE	in
the	PREFERENCES	as	it	tells	you	to	do	then	post	your	output	again	as	there	appears	to	be	some	information	missing.	Some	people	have	reported	issues	with	the	windows	store	version	and	we	would	recommend	installing	the	full	version	of	the	IDE	to	see	if	that	improves	your	experience.	Page	3	Arduino:1.8.13	(Windows	10),	Ploča:	"Arduino	Uno"
Skica	koristi	724	bytes	(2%)	od	prostora	za	program.	Maximum	je	32256	bajtova.	Globalne	promjenjljive	koriste	9	bajtova	(0%)	RAM-a,	ostalo	je	2039	bajtova	za	lokalne	promjenjljive.	Maximim	je	2048	bajtova.	C:\Program	Files	(x86)\Arduino\hardware\tools\avr/bin/avrdude	-CC:\Program	Files	(x86)\Arduino\hardware\tools\avr/etc/avrdude.conf	-v	-
patmega328p	-carduino	-PCOM3	-b115200	-D	-Uflash:w:C:\Users\Marija\AppData\Local\Temp\arduino_build_52047/try_ma.ino.hex:i	avrdude:	Version	6.3-20190619	Copyright	(c)	2000-2005	Brian	Dean,	Copyright	(c)	2007-2014	Joerg	Wunsch	System	wide	configuration	file	is	"C:\Program	Files	(x86)\Arduino\hardware\tools\avr/etc/avrdude.conf"	Using
Port	:	COM3	Using	Programmer	:	arduino	Overriding	Baud	Rate	:	115200	An	error	occurred	while	uploading	the	sketch	This	report	would	have	more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in	File	->	Preferences.	1	Like	Arduino:	1.8.13	(Windows	10),	Board:	"Arduino	Uno"	Sketch	uses	2456	bytes	(7%)	of	program
storage	space.	Maximum	is	32256	bytes.	Global	variables	use	220	bytes	(10%)	of	dynamic	memory,	leaving	1828	bytes	for	local	variables.	Maximum	is	2048	bytes.	C:\Program	Files	(x86)\Arduino\hardware\tools\avr/bin/avrdude	-CC:\Program	Files	(x86)\Arduino\hardware\tools\avr/etc/avrdude.conf	-v	-patmega328p	-carduino	-PCOM7	-b115200	-D	-
Uflash:w:C:\Users\Acer\AppData\Local\Temp\arduino_build_487933/test_sensor.ino.hex:i	avrdude:	Version	6.3-20190619	Copyright	(c)	2000-2005	Brian	Dean,	Copyright	(c)	2007-2014	Joerg	Wunsch	System	wide	configuration	file	is	"C:\Program	Files	(x86)\Arduino\hardware\tools\avr/etc/avrdude.conf"	Using	Port	:	COM7	Using	Programmer	:	arduino
Overriding	Baud	Rate	:	115200	An	error	occurred	while	uploading	the	sketch	This	report	would	have	more	information	with	"Show	verbose	output	during	compilation"	option	enabled	in	File	->	Preferences.	1	Like	Arduino:	1.8.16	(Windows	Store	1.8.51.0)	(Windows	10),	Board:	"Arduino	Uno"	C:\Program
Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\arduino-builder	-dump-prefs	-logger=machine	-hardware	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware	-tools	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\tools-builder	-tools
C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-built-in-libraries	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\libraries	-libraries	C:\Users\royiz\Documents\Arduino\libraries	-fqbn=arduino:avr:uno	-vid-pid=0000_0000	-ide-version=10816	-build-
path	C:\Users\royiz\AppData\Local\Temp\arduino_build_735519	-warnings=none	-build-cache	C:\Users\royiz\AppData\Local\Temp\arduino_cache_37859	-prefs=build.warn_data_percentage=75	-prefs=runtime.tools.avr-gcc.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-
prefs=runtime.tools.avr-gcc-7.3.0-atmel3.6.1-arduino7.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.arduinoOTA.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-
prefs=runtime.tools.arduinoOTA-1.3.0.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.avrdude.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.avrdude-6.3.0-
arduino17.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-verbose	C:\Users\royiz\Documents\Arduino\sound_sensor\sound_sensor.ino	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\arduino-builder	-compile	-logger=machine	-hardware
C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware	-tools	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\tools-builder	-tools	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-built-in-libraries	C:\Program
Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\libraries	-libraries	C:\Users\royiz\Documents\Arduino\libraries	-fqbn=arduino:avr:uno	-vid-pid=0000_0000	-ide-version=10816	-build-path	C:\Users\royiz\AppData\Local\Temp\arduino_build_735519	-warnings=none	-build-cache
C:\Users\royiz\AppData\Local\Temp\arduino_cache_37859	-prefs=build.warn_data_percentage=75	-prefs=runtime.tools.avr-gcc.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.avr-gcc-7.3.0-atmel3.6.1-arduino7.path=C:\Program
Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.arduinoOTA.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.arduinoOTA-1.3.0.path=C:\Program
Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.avrdude.path=C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-prefs=runtime.tools.avrdude-6.3.0-arduino17.path=C:\Program
Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\tools\avr	-verbose	C:\Users\royiz\Documents\Arduino\sound_sensor\sound_sensor.ino	Using	board	'uno'	from	platform	in	folder:	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\arduino\avr	Using	core	'arduino'
from	platform	in	folder:	C:\Program	Files\WindowsApps\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\hardware\arduino\avr	Detecting	libraries	used...	"C:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\tools\\avr/bin/avr-g++"	-c	-g	-Os	-w	-std=gnu++11	-fpermissive	-fno-exceptions	-
ffunction-sections	-fdata-sections	-fno-threadsafe-statics	-Wno-error=narrowing	-flto	-w	-x	c++	-E	-CC	-mmcu=atmega328p	-DF_CPU=16000000L	-DARDUINO=10816	-DARDUINO_AVR_UNO	-DARDUINO_ARCH_AVR	"-IC:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\arduino\\avr\\cores\\arduino"
"-IC:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\arduino\\avr\\variants\\standard"	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519\\sketch\\sound_sensor.ino.cpp"	-o	nul	Generating	function	prototypes...	"C:\\Program
Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\tools\\avr/bin/avr-g++"	-c	-g	-Os	-w	-std=gnu++11	-fpermissive	-fno-exceptions	-ffunction-sections	-fdata-sections	-fno-threadsafe-statics	-Wno-error=narrowing	-flto	-w	-x	c++	-E	-CC	-mmcu=atmega328p	-DF_CPU=16000000L	-DARDUINO=10816	-
DARDUINO_AVR_UNO	-DARDUINO_ARCH_AVR	"-IC:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\arduino\\avr\\cores\\arduino"	"-IC:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\arduino\\avr\\variants\\standard"
"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519\\sketch\\sound_sensor.ino.cpp"	-o	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519\\preproc\\ctags_target_for_gcc_minus_e.cpp"	"C:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\tools-builder\\ctags\\5.8-arduino11/ctags"	-u	--
language-force=c++	-f	-	--c++-kinds=svpf	--fields=KSTtzns	--line-directives	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519\\preproc\\ctags_target_for_gcc_minus_e.cpp"	Compiling	sketch...	"C:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\tools\\avr/bin/avr-g++"	-c	-g	-Os	-w	-
std=gnu++11	-fpermissive	-fno-exceptions	-ffunction-sections	-fdata-sections	-fno-threadsafe-statics	-Wno-error=narrowing	-MMD	-flto	-mmcu=atmega328p	-DF_CPU=16000000L	-DARDUINO=10816	-DARDUINO_AVR_UNO	-DARDUINO_ARCH_AVR	"-IC:\\Program
Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\arduino\\avr\\cores\\arduino"	"-IC:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\arduino\\avr\\variants\\standard"
"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519\\sketch\\sound_sensor.ino.cpp"	-o	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519\\sketch\\sound_sensor.ino.cpp.o"	Compiling	libraries...	Compiling	core...	Using	precompiled	core:
C:\Users\royiz\AppData\Local\Temp\arduino_cache_37859\core\core_arduino_avr_uno_181e0f64b51f9dc50a0bb8aa27d6db3e.a	Linking	everything	together...	"C:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\tools\\avr/bin/avr-gcc"	-w	-Os	-g	-flto	-fuse-linker-plugin	-Wl,--gc-sections	-
mmcu=atmega328p	-o	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519/sound_sensor.ino.elf"	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519\\sketch\\sound_sensor.ino.cpp.o"
"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519/..\\arduino_cache_37859\\core\\core_arduino_avr_uno_181e0f64b51f9dc50a0bb8aa27d6db3e.a"	"-LC:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519"	-lm	"C:\\Program	Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\tools\\avr/bin/avr-
objcopy"	-O	ihex	-j	.eeprom	--set-section-flags=.eeprom=alloc,load	--no-change-warnings	--change-section-lma	.eeprom=0	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519/sound_sensor.ino.elf"	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519/sound_sensor.ino.eep"	"C:\\Program
Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\tools\\avr/bin/avr-objcopy"	-O	ihex	-R	.eeprom	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519/sound_sensor.ino.elf"	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519/sound_sensor.ino.hex"	"C:\\Program
Files\\WindowsApps\\ArduinoLLC.ArduinoIDE_1.8.51.0_x86__mdqgnx93n4wtt\\hardware\\tools\\avr/bin/avr-size"	-A	"C:\\Users\\royiz\\AppData\\Local\\Temp\\arduino_build_735519/sound_sensor.ino.elf"	Sketch	uses	2098	bytes	(6%)	of	program	storage	space.	Maximum	is	32256	bytes.	Global	variables	use	202	bytes	(9%)	of	dynamic	memory,	leaving
1846	bytes	for	local	variables.	Maximum	is	2048	bytes.	An	error	occurred	while	uploading	the	sketch	An	error	occurred	while	uploading	the	sketch	Hi	@royizzat.	In	order	to	gather	more	information	that	might	help	us	to	troubleshoot	your	problem,	I'm	going	to	ask	you	to	post	the	full	output	from	the	upload	when	in	verbose	mode.	Please	do	this:	Select
File	>	Preferences	from	the	Arduino	IDE's	menus.	Uncheck	the	checkbox	next	to	Show	verbose	output	during:	[]	compilation	Check	the	checkbox	next	to	Show	verbose	output	during:	[]	upload.	Click	the	OK	button.	Attempt	an	upload,	as	you	did	before.	After	the	upload	fails,	you'll	see	a	button	on	the	right	side	of	the	orange	bar	in	the	Arduino	IDE:
Copy	error	messages.	Click	that	button.	This	copies	the	full	output	to	the	clipboard.	Open	a	forum	reply	here	by	clicking	the	Reply	button.	Click	the	icon	on	the	post	composer	toolbar.	This	will	add	the	forum's	code	block	markup	(```)	to	your	reply	to	make	sure	the	error	messages	are	correctly	formatted.	Press	Ctrl+V.	This	will	paste	the	error	output
from	the	upload	into	the	code	block.	Move	the	cursor	outside	of	the	code	tags	before	you	add	any	additional	text	to	your	reply.	Click	the	Reply	button	to	post	the	output.	2	posts	were	split	to	a	new	topic:	Problem	uploading	a	sketch	to	board	This	topic	was	automatically	closed	after	15	hours.	New	replies	are	no	longer	allowed.	I	am	not	able	to	connect
and	upload	code	in	my	esp32	as	my	PC	is	not	detecting	any	ports,	i	have	tried	downloading	and	installing	the	drivers	which	are	availlable	online	but	still	didn't	got	any	results,and	also	there	are	no	any	hidden	devices	in	device	manager	where	I	can	find	the	ports,	I	am	using	a	proper	data	transfer	USB	cable	and	not	a	charging	cable,	i	also	tried
uninstalling	and	redownloading	the	software	but	still	no	results	were	found,there	is	not	issue	in	my	friend's	PC	and	esp32	is	properly	connecting	to	his	PC	,	only	my	PC	is	having	the	issue,	please	provide	me	a	proper	solution	as	I	am	not	able	to	do	my	project.	what	esp32	board	do	you	have	?	I	recently	had	a	similar	issue	and	found	the	solution	here	by
chance.	Take	your	ESP32	without	any	connection	done	to	it	and	do	the	following:	press	and	hold	the	BOOT	button	on	the	ESP32	then	plug	in	the	USB	cable	from	the	ESP32	to	your	PC.	You	should	hear	the	connection	sound	from	your	PC	and	then	see	a	proper	USB	port.	If	it	does	not	work	at	once	press	the	RESET	button	a	couple	of	times	and	repeat
the	procedure.	I	have	5	different	ESP32	boards	which	I	thought	that	they	are	burnt	and	with	this	procedure	I	got	them	back	to	life	.	I	have	esp32	Dev	Module,	I	tried	the	trick	as	you	said	but	it	too	didn't	worked.Thanks	for	your	advice.	Try	a	different	cable	or	connect	to	another	computer.	I	see	here	what	you	are	explaining.	Many	times	for	me	it	works
then	quits.	It	happens	mainly	with	the	ESP	devices.	same	problem	with	me	please	give	me	solution	Hi	@vishwjeet1231.	Please	add	a	reply	here	on	this	forum	topic	to	tell	us	which	Arduino	board	you	are	using.	Please	be	as	specific	as	possible,	as	some	Arduino	boards	with	similar	names	have	significant	differences	and	the	forum	helpers	can	only
provide	effective	assistance	if	we	are	aware	of	which	one	is	being	used.	If	you	aren't	sure	how	to	describe	which	board	you	are	using,	you	can	provide	the	link	to	the	online	product	listing	you	bought	the	board	from	and	we'll	proceed	based	on	the	information	found	there.	my	error	is	resolved	i	have	installed	driver	Hello,	which	driver	have	you
installed?	im	going	through	the	exact	same	problem	1	Like	Hi	@manas_musunuri.	Please	add	a	reply	here	on	this	forum	topic	to	tell	us	which	Arduino	board	you	are	using.	Please	be	as	specific	as	possible,	as	some	Arduino	boards	with	similar	names	have	significant	differences	and	the	forum	helpers	can	only	provide	effective	assistance	if	we	are
aware	of	which	one	is	being	used.	If	you	aren't	sure	how	to	describe	which	board	you	are	using,	you	can	provide	the	link	to	the	online	product	listing	you	bought	the	board	from	and	we'll	proceed	based	on	the	information	found	there.	1	Like	Hello,	after	upgrading	to	version	2.3.3	I	have	a	problem	compiling	my	ESP32	module.	I	have	a	problem	with	the
message:	thread	'main'	panicked	at	'assertion	failed:	(left	!=	right)	left:	0,	right:	0:	Failed	to	get	path	name.	Error	code:	3',	main.rs:65:9	note:	run	with	RUST_BACKTRACE=1	environment	variable	to	display	a	backtrace	exit	status	101	Compilation	error:	exit	status	101	Does	anyone	know	how	to	solve	the	problem?	Thanks	and	have	a	nice	day
marosh555:	after	upgrading	to	version	2.3.3	From	what?	From	IDE	1.x	or	from	IDE	2.x	(2.3.2?)?	Was	that	the	only	upgrade	or	did	you	also	upgrade	the	board	package	and/or	libraries?	Which	operating	system	are	you	using.	What	you	can	try	is	to	downgrade	the	ESP32	board	package	in	case	that	was	also	upgraded.	If	that	works,	you	can	upgrade	it
again;	if	that	upgrade	fails	it	has	something	to	do	with	the	board	package.	Further	I	can't	really	help;	here	are	some	search	results:	esp32	thread	'main'	panicked	at	'assertion	failed:	(left	!=	right)	-	Google	Search	Note:	This	might	be	IDE	2.x	related	(though	not	directly)	and	not	hardware	related	and	hence	your	topic	has	been	moved	to	the	IDE	2.x
section	of	the	forum.	From	version	2.3.2	on	Windows	10.	I	have	already	tried	installing	the	original	version	2.3.2	but	the	result	is	the	same.	Yesterday	when	I	was	writing	the	program	everything	worked	without	problems	and	after	the	update	this	happened	to	me.	The	problem	was	solved	when	I	downgraded	the	esp	board.	Thanks	for	help	with	my
problem	sterretje	I	had	the	same	problem	if	you	use	Windows	10	like	me.	I	solved	it!	After	a	long	time	of	trying,	I	figured	out	that	the	account	name	and	computer	name	must	be	without	diacritics.	After	changing	without	diacritics,	I	installed	the	esp32	boards	(from	Espressif	system)	in	the	latest	version	3.1.1	without	any	problems.	1	Like	How	did	you
rename	the	account	name	and	computer	name?	The	/users/'YourName'	folder	can't	be	changed	or	am	I	wrong?	I	changed	my	username	because	I	had	the	same	problem	(my	name	is	José,	I	change	it	to	Jose	without	the	diacrytic	accent)	and	it	solves	it.	You	have	to	be	careful,	doing	that	can	damage	your	user	sesion,	so	these	are	the	steps	you	should



follow.	1st.	Be	an	administrator.	2nd.	Create	another	user	with	administration	privilegies.	3rd.	Enter	in	that	user	sesison	and	change	your	user	file	name	as	you	wish.	4th.	Finally	you	have	to	change	the	register	of	the	users	on	the	computer,	so	open	redegit	and	find	this	path:	HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\ProfileList\	there	are	the	profiles	path	to	each	username,	find	yours	and	change	the	original	one	to	the	new	path,	for	example:	C:\Users\OldOne	to	C:\Users\NewOne	in	the	profileImagePath	that's	is	all.	Then	you	have	to	reset	the	computer,	and	be	able	to	enter	your	session.	My	recommendation	is	to	create	another	user	and	just	use
the	new	user,	doing	the	previus	can	damage	your	installation	of	some	programs	that	path	your	username	profile	archives	(I	got	the	reinstall	Arduino	and	repair	some	path	issues	because	I	did	that,	it's	annoying	but	it's	possible).	That's	it,	be	careful	doing	that	seriously	(I	google	it	when	I	did	it	and	it	works	but	causes	some	issues	as	I	said).	Thanks	for
sharing	the	solution	you	found	@juanjgomezb!	I'll	mention	an	alternative	workaround	for	those	who	are	encountering	problems	caused	by	characters	in	their	Windows	user	folder	name.	This	workaround	might	be	preferrable	to	those	who	don't	feel	comfortable	making	the	changes	to	the	registry	as	is	required	to	change	the	folder	name.	The
alternative	is	to	configure	Arduino	IDE	to	use	different	paths	on	your	computer,	which	are	not	under	the	user	folder	(and	that	only	contain	basic	ASCII	characters):	These	instructions	will	only	work	for	Arduino	IDE	versions	2.3.4	or	newer.	Select	File	>	Quit	from	the	Arduino	IDE	menus	if	it	is	running.	All	IDE	windows	will	close.	Open	the	file	at	the
following	path	in	any	text	editor:C:\Users\\.arduinoIDE\arduino-cli.yaml	(where	is	your	Windows	username)	Add	the	following	content	to	the	arduino-cli.yaml	file	(or	replace	the	existing	content	if	equivalent	content	is	already	present	in	the	file):build_cache:	path:	directories:	builtin:	libraries:	data:	user:	Replace	the	placeholder	with	the	path	to	the
folder	under	which	you	want	Arduino	to	store	the	cached	data	for	compiling	sketches.	For	this,	and	for	the	paths	in	the	subsequent	instructions,	make	sure	to	chose	a	location	that	is	not	under	any	folders	with	names	that	contain	anything	other	than	basic	ASCII	characters	(e.g.,	A-z,	0-9,	_,	-,	.,	).	Arduino	IDE	periodically	deletes	contents	of	this	folder
(the	files	stored	under	it	are	only	cached	there	for	the	sake	of	efficiency,	and	it	can	always	regenerate	the	files	on	demand),	so	you	should	not	use	this	folder	to	store	any	valuable	files.	Replace	the	placeholder	with	the	path	to	the	folder	under	which	you	want	Arduino	to	store	some	fundamental	"built-in"	Arduino	libraries.	Replace	the	placeholder	with
the	path	to	the	folder	under	which	you	want	Arduino	to	store	the	boards	platforms	you	install	via	Boards	Manager,	as	well	as	some	other	data	files.	Replace	the	placeholder	with	the	path	you	want	to	use	as	the	Arduino	sketchbook	(the	folder	under	Arduino	IDE	stores	libraries	you	install	via	Library	Manager	and	"Add	.ZIP	Library...",	as	well	as	a
convenient	location	to	save	your	sketches).		Unlike	the	other	paths,	you	can	also	configure	this	one	via	Arduino	IDE's	preferences	GUI.	I	thought	I	should	include	it	in	these	instructions	just	to	be	comprehensive.	Save	the	file.	Move	the	files	from	this	folder	on	your	hard	drive:C:\Users\\AppData\Local\Arduino15\libraries	(where	is	your	Windows
username)	to	the	folder	you	configured	in	step	(5)	above	("").	Move	the	files	from	this	folder	on	your	hard	drive:C:\Users\\AppData\Local\Arduino15	to	the	folder	you	configured	in	step	(6)	above	("").	If	you	configured	a	different	sketchbook	folder	location	in	step	(7)	above,	move	the	files	from	the	previous	sketchbook	folder	location	to	the	new	one.
Start	Arduino	IDE.	I	also	found	an	alternative	workaround,	which	is	perhaps	a	bit	risky	so	I	don't	necessarily	recommend	it,	but	maybe	of	interest	to	advanced	users	so	I'll	add	a	link	to	it:	2	Likes	This	topic	was	automatically	closed	180	days	after	the	last	reply.	New	replies	are	no	longer	allowed.	If	you	are	using	a	recent	version	of	the	IDE,	you	will	get
an	auto-update	offer	simply	by	starting	the	IDE.	Otherwise,	the	release	is	available	for	download	here:	This	release	provides	some	nice	advancements	and	fixes.	Thanks	so	much	to	the	forum	community	for	all	the	valuable	testing	and	feedback	that	has	helped	us	greatly	in	identifying	and	investigating	these	bugs	and	enhancements!	Highlights	Sanitize
notification	messages	Gracefully	handle	invalid	package	index	URLs	Sanitize	notification	messages	arduino/arduino-ide#2664	Arduino	IDE	uses	notifications	to	communicate	information	about	various	events	(e.g.,	completion	of	an	upload)	to	the	user.	In	some	cases,	the	text	of	the	notification	message	might	contain	content	that	comes	from	external
sources.	It	is	possible	that	an	attacker	could	introduce	malicious	content	into	the	notification	message	text,	using	it	for	a	cross-site	scripting	attack:	GitHub	###	Introduction	A	Self	Cross-Site	Scripting	(XSS)	vulnerability	has	been	identified	within	the	Arduino-IDE	prior	to	version	v2.3.5	This	type	of	attack	occurs	when	user	input	is	not	properly	sa...
Sanitization	code	has	been	added	to	render	any	potentially	malicious	content	in	the	notification	message	harmless.	Gracefully	handle	invalid	package	index	URLs	arduino/arduino-ide#2645,	arduino/arduino-cli#2817,	arduino/arduino-cli#2786	Support	for	specific	board	models	in	Arduino	IDE	is	provided	by	Arduino	boards	platforms.	Platforms	can	be
installed	via	Boards	Manager.	Boards	Manager	uses	data	published	to	the	Internet	in	a	package	index	file.	In	order	to	install	a	3rd	party	boards	platform,	the	user	must	first	add	the	URL	of	that	platform's	package	index	to	Arduino	IDE's	"Additional	Boards	Manager	URLs"	preference.	Previously,	if	the	user	added	an	invalid	URL	to	the	"Additional
Boards	Manager	URLs"	preference,	it	would	cause	Arduino	IDE	to	be	non-functional	and	the	only	way	to	restore	it	from	that	state	was	to	manually	remove	the	invalid	data	from	an	obscure	configuration	file.	Arduino	IDE	will	now	gracefully	handle	invalid	"Additional	Boards	Manager	URLs"	preference	data.	Of	course,	the	dependent	boards	platform
will	still	not	be	available	for	installation	via	Boards	Manager	under	these	conditions,	but	the	user	will	now	be	able	to	easily	correct	their	mistake	via	the	Arduino	IDE	preferences	GUI	if	this	happens.	(Thanks	@jjmurflo)	Update	Eclipse	Theia	Platform	framework	to	1.57.0	arduino/arduino-ide#2654	Arduino	IDE	is	built	on	the	free	open	source	Eclipse
Theia	Platform	framework.	In	order	to	benefit	from	the	ongoing	development	work	in	the	Eclipse	Theia	Platform	project,	Arduino	IDE	has	been	updated	to	using	Eclipse	Theia	Platform	version	1.57.0.	(Thanks	@dankeboy36)	Reliably	provide	"state"	information	to	extensions	arduino/arduino-ide#2643,	arduino/arduino-ide#2642	Arduino	IDE	has	a
powerful	and	flexible	extension	framework.	Anyone	can	add	additional	capabilities	to	Arduino	IDE	without	making	any	modifications	to	the	IDE's	codebase.	In	addition	to	its	general	support	for	VS	Code	extensions,	Arduino	IDE	also	provides	supplemental	"state"	information	specific	to	Arduino	sketch	development,	which	may	be	required	by	extensions
written	by	the	Arduino	community.	Previously,	that	"state"	information	was	unnecessarily	withheld	under	certain	conditions.	(Thanks	@dankeboy36)	Update	Arduino	CLI	dependency	to	1.2.0	arduino/arduino-ide#2645	Much	of	the	non-GUI	functionality	of	Arduino	IDE	comes	from	the	Arduino	CLI	tool.	In	order	to	benefit	from	the	ongoing	development
work	in	the	Arduino	CLI	project,	Arduino	IDE	has	been	updated	to	using	Arduino	CLI	version	1.2.0.	Fix	coloration	of	preprocessor	stderr	output	arduino/arduino-ide#2645,	arduino/arduino-cli#2806	The	output	from	the	tools	used	to	compile	and	upload	Arduino	sketches	is	displayed	in	Arduino	IDE's	"Output"	panel.	The	text	is	colored	to	communicate
its	significance	to	the	user.	The	output	from	the	tool's	"standard	output"	stream	is	colored	white,	and	the	the	output	from	the	"standard	error"	stream	colored	red.	Errors	or	warnings	may	be	produced	by	the	C	preprocessor,	and	it	prints	these	to	the	standard	error	stream.	Previously,	this	text	was	incorrectly	given	the	standard	output	coloration.	Add
support	for	configuring	Arduino	CLI	network	timeout	via	settings	file	arduino/arduino-ide#2645,	arduino/arduino-cli#2770,	arduino/arduino-cli#2769	Much	of	the	non-GUI	functionality	of	Arduino	IDE	comes	from	the	Arduino	CLI	tool.	Arduino	CLI	uses	various	resources	from	the	Internet,	and	thus	makes	network	requests	under	certain	conditions.	In
some	unusual	use	cases,	it	might	be	useful	to	the	user	to	be	able	to	configure	a	specific	timeout	duration	for	requests	that	don't	receive	a	response	due	to	exceptional	network	conditions.	This	can	now	be	done	via	the	network.connection_timeout	key	of	the	Arduino	CLI	configuration	file	used	by	Arduino	IDE.	Add	support	for	disabling	enhanced	port
identification	arduino/arduino-ide#2645,	arduino/arduino-cli#2770,	arduino/arduino-cli#2769	Support	for	specific	board	models	in	Arduino	IDE	is	provided	by	Arduino	boards	platforms.	With	the	exception	of	the	foundational	"Arduino	AVR	Boards"	platform,	which	is	automatically	installed	by	Arduino	IDE,	the	user	must	install	the	necessary	platform
before	they	can	use	their	board.	New	users	who	aren't	aware	of	that	requirement	and	so	don't	install	the	platform	dependency	might	think	that	their	board	or	the	IDE	is	broken.	The	ports	of	Arduino	boards	can	be	automatically	identified	by	Arduino	IDE	via	the	port's	identification	properties.	This	is	used	for	convenience	features	such	as	labeling	the
ports	in	the	Tools	>	Port	menu	(e.g.,	"COM42	(Arduino	Uno)")	The	primary	source	of	the	board	model	/	port	property	association	data	is	the	boards	platform.	However,	if	the	platform	for	the	connected	board	is	not	installed	then	that	information	will	not	be	available	to	Arduino	IDE.	For	this	reason,	a	secondary	port	identification	system	has	been
implemented,	which	obtains	board	model	associations	from	an	online	API.	The	ability	to	identify	ports	of	Arduino	boards	for	which	no	platform	is	installed	is	very	useful	because	it	allows	Arduino	IDE	to	automatically	offer	to	install	the	missing	platform	dependency	for	the	user,	supporting	a	natural	user	flow	for	the	first	use	of	a	board	and	thus	making
the	learning	curve	more	gentle	for	new	users:	The	port	identification	functionality	is	provided	by	the	Arduino	CLI	tool.	Advanced	configuration	of	this	tool	can	be	made	via	a	configuration	file.	In	some	unusual	or	advanced	use	cases,	the	user	might	want	to	disable	the	feature	for	identifying	the	board	port	via	the	online	API.	This	can	now	be	done	via
the	network.cloud_api.skip_board_detection_calls	key	of	the	Arduino	CLI	configuration	file	used	by	Arduino	IDE.	Add	support	to	library	discovery	system	for	compilers	with	unusual	error	message	format	arduino/arduino-ide#2645,	arduino/arduino-cli#2782	The	C++	compiler	must	be	configured	with	the	paths	of	all	library	dependencies	of	a	sketch.
The	Arduino	sketch	build	system	handles	this	automatically.	This	"library	discovery"	system	works	by	tentatively	running	the	C	preprocessor	on	the	sketch	program.	If	preprocessing	fails,	the	system	parses	the	text	of	the	preprocessor's	error	messages.	If	the	error	was	caused	by	the	absence	of	a	file	referenced	by	one	of	the	sketch	program's	#include
directives,	this	indicates	that	the	path	to	the	library	dependency	providing	the	header	file	has	not	yet	been	added	to	the	compiler's	"search	path".	It	turns	out	that	some	rarely	used	compilers	use	an	unusual	format	for	these	error	messages,	and	the	parsing	code	was	not	able	to	correctly	recognize	the	messages	in	that	format.	The	library	discovery
code	has	now	been	updated	to	add	support	for	those	compilers.	Add	support	for	disabling	platform	installation	integrity	checks	arduino/arduino-ide#2645,	arduino/arduino-cli#2740,	arduino/arduino-cli#1468	Support	for	specific	board	models	in	Arduino	IDE	is	provided	by	Arduino	boards	platforms.	Platforms	can	be	installed	via	Boards	Manager,
which	downloads	the	archive	files	for	the	platform	from	the	Internet.	By	default,	Boards	Manager	checks	the	downloaded	archives	against	the	checksum	defined	by	the	platform's	package	index	in	order	to	ensure	the	file	was	not	corrupted.	Although	this	is	very	useful	behavior	for	any	production	usage,	it	can	be	inconvenient	in	advanced	use	cases
where	a	package	index	provides	beta	tester	versions	of	the	platform,	which	are	continuously	updated	as	the	platform's	development	work	progresses.	These	users	can	now	disable	that	integrity	check	via	the	board_manager.enable_unsafe_install	key	of	the	Arduino	CLI	configuration	file	used	by	Arduino	IDE.	(Thanks	@obra)	Only	delay	after	serial
output	in	"Knock"	built-in	example	arduino/arduino-ide#2646,	arduino/arduino-examples#81,	arduino/docs-content#2159	A	collection	of	example	sketches	demonstrating	various	concepts	are	bundled	with	the	Arduino	IDE	installation.	The	"Knock"	example	uses	a	piezo	disc	to	detect	the	vibrations	associated	with	a	knock.	Previously	a	"debouncing"
delay	was	incorrectly	positioned	in	the	example	code,	which	caused	it	to	miss	detection	of	some	knocks.	(Thanks	@thespiffer1)	Document	incomplete	nature	of	"p08_DigitalHourglass"	built-in	example	arduino/arduino-ide#2646,	arduino/arduino-examples#84,	arduino/arduino-examples#83	A	collection	of	example	sketches	are	bundled	with	the
Arduino	IDE	installation.	These	include	the	sketches	that	accompany	the	Arduino	Starter	Kit.	The	"p08_DigitalHourglass"	sketch	is	intentionally	left	incomplete.	The	Arduino	Projects	Book	that	comes	with	the	starter	kit	instructs	the	user	to	add	their	own	code	to	indicate	the	completion	of	the	timer.	In	addition	to	owners	of	the	Arduino	Starter	Kit,
other	users	might	use	this	sketch	as	a	reference,	and	thus	not	have	the	context	provided	by	the	Arduino	Projects	Book.	Comments	were	added	to	the	sketch	to	instruct	the	user	to	add	the	missing	code.	(Thanks	@DaveX)	Expand	and	improve	translations	arduino/arduino-ide#2597,	arduino/arduino-ide#2645,	arduino/arduino-cli#2771	The	community
work	to	make	Arduino	IDE	accessible	to	everyone	in	the	world	through	localization	of	the	text	of	the	IDE's	UI	continues,	reaching	high	coverage	levels	for	18	languages/locales.	If	you	would	like	to	contribute	to	the	Arduino	IDE	translations,	please	see	the	information	here:	Full	changelog	here:	If	you	have	any	questions	or	feedback	please	post	here	in
the	dedicated	forum	category	for	Arduino	IDE	2.x:	If	you	want	to	see	the	list	of	known	issues,	work	in	progress,	submit	a	formal	report,	or	contribute	to	development,	the	Arduino	IDE	2.x	source	code	is	hosted	in	this	public	repository:	If	you	are	using	a	recent	version	of	the	IDE,	you	will	get	an	auto-update	offer	simply	by	starting	the	IDE.	Otherwise,
the	release	is	available	for	download	here:	This	release	provides	some	nice	advancements	and	fixes.	Thanks	so	much	to	the	forum	community	for	all	the	valuable	testing	and	feedback	that	has	helped	us	greatly	in	identifying	and	investigating	these	bugs	and	enhancements!	Deprecation	notice:	Upcoming	cessation	of	support	for	Linux	distros	using
glibc	2.28	Recent	changes	in	the	framework	used	to	produce	automated	release	of	Arduino	IDE	resulted	in	the	loss	of	compatibility	of	the	Linux	builds	with	older	Linux	distro	versions	that	use	version	2.28	of	the	GNU	C	Library	(glibc)	shared	library.	This	includes	Ubuntu	18.04.	Arduino	IDE	2.3.4	will	be	the	last	version	that	can	be	used	with	these
distro	versions.	Future	releases	(including	nightly	and	tester	builds)	will	fail	to	start	on	machines	using	these	distro	versions	with	an	error	like:	Error:	node-loader:	Error:	/lib/x86_64-linux-gnu/libc.so.6:	version	`GLIBC_2.28'	not	found	(required	by	/home/foo/arduino-ide/resources/app/lib/backend/native/pty.node)	at	85467	(/home/foo/arduino-
ide/resources/app/lib/backend/main.js:2:2766)	at	__webpack_require__	(/home/foo/arduino-ide/resources/app/lib/backend/main.js:2:6663105)	at	23571	(/home/foo/arduino-ide/resources/app/lib/backend/main.js:2:3374073)	at	__webpack_require__	(/home/foo/arduino-ide/resources/app/lib/backend/main.js:2:6663105)	at	55444	(/home/foo/arduino-
ide/resources/app/lib/backend/main.js:2:3369761)	at	__webpack_require__	(/home/foo/arduino-ide/resources/app/lib/backend/main.js:2:6663105)	at	24290	(/home/foo/arduino-ide/resources/app/lib/backend/main.js:2:1780542)	at	__webpack_require__	(/home/foo/arduino-ide/resources/app/lib/backend/main.js:2:6663105)	at	43416	(/home/foo/arduino-
ide/resources/app/lib/backend/main.js:2:1770138)	at	__webpack_require__	(/home/foo/arduino-ide/resources/app/lib/backend/main.js:2:6663105)	If	you	don't	know	which	version	of	glibc	your	machine	is	using,	run	this	from	the	terminal:	/lib/x86_64-linux-gnu/libc.so.6	Further	technical	details	are	available	here.	The	recommended	path	forward	is	to
update	to	a	modern	version	of	Linux.	If	you	can't	or	won't	do	that,	you	can	update	to	the	last	compatible	version	of	Arduino	IDE,	2.3.4,	and	then	avoid	updating	when	future	releases	(e.g.,	2.3.5)	come	out.	There	are	two	methods	for	dealing	with	these	update	offers.	I'll	provide	instructions	for	both	of	them.	You	can	pick	whichever	one	of	the	two	is	most
convenient	for	you.	"SKIP	VERSION"	The	"Update	Available"	dialog	contains	a	"SKIP	VERSION"	button.	If	you	click	that	button,	Arduino	IDE	will	no	longer	show	the	dialog	for	the	specific	newer	version	being	offered	at	the	time	you	click	the	button.	The	dialog	will	appear	once	again	each	time	Arduino	releases	a	new	version	of	Arduino	IDE,	so	you	will
need	to	click	the	button	again	after	each	release.	That	is	slightly	inconvenient,	but	the	release	cycle	is	fairly	long	so	I	don't	think	it	will	be	very	burdensome.	Disable	All	Update	Offers	It	is	possible	to	completely	disable	the	offers	of	updates	in	the	Arduino	IDE	advanced	settings.	The	downside	is	this	setting	also	disables	offers	of	updates	for	your
installed	boards	platforms	and	libraries.	Press	the	Ctrl+Shift+P	keyboard	shortcut	(Command+Shift+P	for	macOS	users)	to	open	the	"Command	Palette".	A	menu	will	appear	on	the	editor	toolbar:	Select	the	"Preferences:	Open	Settings	(UI)"	command	from	the	menu.		You	can	scroll	down	through	the	list	of	commands	to	find	it	or	type	the	name	in	the
field.	A	"Preferences"	tab	will	open	in	the	Arduino	IDE	main	panel.	Type	arduino.checkForUpdates	in	the	"Search	Settings"	field	of	the	"Preferences"	tab.	Uncheck	the	box	under	the	"Arduino:	Check	For	Updates"	setting.	Close	the	Preferences	tab	by	clicking	its	X	icon.	Keeping	Your	Arduino	Dependencies	Updated	If	you	chose	this	"Disable	All	Update
Offers"	method,	make	sure	to	periodically	check	to	see	if	newer	versions	of	your	installed	boards	platforms	and	libraries	are	available.	You	can	do	this	by	opening	Boards	Manager	and	then	setting	the	"Type"	menu	to	"Updatable",	then	repeating	the	process	with	Library	Manager.	There	is	no	possibility	of	a	problem	using	newer	versions	of	Arduino
libraries	on	a	computer	with	an	older	version	of	Linux,	so	don't	worry	about	an	incompatibility	when	updating	your	libraries.	It	is	theoretically	possible	that	some	future	version	of	a	boards	platform	could	have	an	increased	minimum	Linux	version	requirement	in	its	tool	dependencies.	Even	if	you	did	encounter	that	a	boards	platform	stopped	working
after	an	update,	you	can	always	easily	downgrade	the	platform	back	to	the	last	working	version	via	the	Arduino	IDE	Boards	Manager.	Fix	operations	hanging	while	Serial	Monitor/Plotter	is	open	arduino/arduino-ide#2571,	arduino/arduino-ide#2562,	arduino/arduino-cli#2728,	arduino/arduino-cli#2719	A	bug	was	introduced	in	Arduino	IDE	2.3.3	that
caused	operations	such	as	downloading	Boards	Manager	package	index	files	to	hang	if	performed	while	Serial	Monitor	or	Serial	Plotter	is	open.	The	bug	has	now	been	fixed.	(Thanks	@k5map	and	@starthemorning)	Fix	bug	causing	failed	uploads	to	be	indicated	as	successful	arduino/arduino-ide#2518,	arduino/arduino-ide#2516	At	the	termination	of
an	upload	operation,	Arduino	IDE	displays	a	notification	to	communicate	the	result	to	the	user.	A	bug	was	introduced	in	Arduino	IDE	2.3.3	that	caused	the	IDE	to	display	the	upload	success	notification	even	when	the	upload	failed.	This	bug	has	now	been	fixed.	Fix	compilation	caching	when	library	installation	or	cache	path	contains	non-ASCII
characters	arduino/arduino-ide#2571,	arduino/arduino-cli#2733,	arduino/arduino-cli#2671	In	order	to	reduce	the	sketch	compilation	duration,	Arduino	IDE	caches	the	compiled	files	and	reuses	those	on	subsequent	compilations	when	appropriate.	Previously,	the	caching	did	not	work	when	libraries	were	installed	under	a	path	containing	non-ASCII
characters,	or	when	the	path	where	the	cached	files	are	stored	contained	such	characters.	This	resulted	in	unnecessarily	long	compilation	durations	for	the	affected	users.	(Thanks	@g91_y	and	@vvb333007)	Fix	hang	on	startup	when	Raspberry	Pi	Pico/RP2040	platform	installed	arduino/arduino-ide#2571,	arduino/arduino-cli#2707,	arduino/arduino-
cli#2665,	arduino/pluggable-discovery-protocol-handler#50	Previously,	Arduino	IDE	would	sometimes	hang	on	startup	if	the	user	had	previously	installed	@earlephilhower's	excellent	"Raspberry	Pi	Pico/RP2040"	boards	platform.	Compatibility	with	that	platform	has	now	been	restored.	Kill	tool	process	when	upload	is	canceled	arduino/arduino-
ide#2571,	arduino/arduino-ide#2517,	arduino/arduino-cli#2726	A	"CANCEL"	button	was	added	to	the	progress	notification	Arduino	IDE	shows	during	sketch	compilation	and	upload.	The	user	can	click	this	button	if	for	some	reason	they	wish	to	cancel	the	operation	(e.g.,	it	is	clear	from	the	output	that	the	upload	is	going	to	fail	eventually).	Previously,
the	button	affected	the	Arduino	IDE	GUI,	but	didn't	actually	cancel	the	underlying	process.	This	could	result	in	spurious	failures	of	subsequent	operations	if	the	collided	with	the	still	running	process	from	the	"canceled"	operation.	The	upload	tool	process	is	now	killed	when	the	button	is	clicked.	Display	a	more	helpful	message	when	cryptographic
signature	validation	fails	due	to	incorrect	system	time	arduino/arduino-ide#2571,	arduino/arduino-cli#2750	Index	files	used	by	Arduino	IDE	are	cryptographically	signed.	Arduino	IDE	validates	the	signature	of	these	files.	Signatures	are	time	stamped,	so	if	the	system	time	on	a	users's	computer	is	set	to	a	time	in	the	past,	the	validation	will	fail	due	the
signature	being	considered	invalid	at	any	time	prior	to	the	timestamp.	This	causes	Arduino	IDE	to	hang	on	startup,	with	an	"Error	verifying	signature:	openpgp:	signature	expired"	error	message	in	the	logs.	The	error	message	displayed	under	these	conditions	has	been	updated	to	include	the	hint	"is	your	system	clock	set	correctly?".	Don't	fail	platform
installation	on	mismatch	with	size	fields	of	package	index	arduino/arduino-ide#2571,	arduino/arduino-cli#2739,	arduino/arduino-cli#2332	The	Arduino	IDE	Boards	Manager	is	populated	by	data	from	index	files.	In	addition	to	the	primary	index	file	maintained	by	Arduino,	the	user	can	specify	additional	3rd	party	Arduino	boards	platforms	to	be
included	by	adding	URLs	to	the	"Additional	Boards	Manager	URLs"	preference.	The	package	index	data	includes	the	checksum	and	file	size	for	each	of	the	files	that	will	be	downloaded	by	Arduino	IDE.	The	purpose	of	the	checksum	is	to	ensure	the	downloaded	file	has	not	been	corrupted	in	any	way.	The	purpose	of	the	file	size	data	is	to	allow	Arduino
IDE	to	display	a	progress	indicator	while	downloading	the	file.	Arduino	IDE	1.x	only	validated	the	checksum	after	download,	as	this	is	fully	sufficient.	If	the	maintainer	of	a	package	index	made	an	error	in	the	file	size	value,	the	only	impact	on	the	user	would	be	an	inaccurate	progress	indicator,	so	package	index	maintainers	who	used	Arduino	IDE	1.x
would	not	have	any	sign	of	their	error.	Previously,	Arduino	IDE	2.x	validated	the	file	size	against	the	package	index.	This	resulted	in	unnecessary	boards	platform	installation	failures.	It	is	now	changed	to	only	validate	against	the	checksum.	Improve	resiliency	to	errors	in	package	indexes	arduino/arduino-ide#2571,	arduino/arduino-cli#2713	The
Arduino	IDE	Boards	Manager	is	populated	by	data	from	index	files.	In	addition	to	the	primary	index	file	maintained	by	Arduino,	the	user	can	specify	additional	3rd	party	Arduino	boards	platforms	to	be	included	by	adding	URLs	to	the	"Additional	Boards	Manager	URLs"	preference.	The	maintainers	of	the	package	index	files	occasionally	introduce
errors	in	the	data	format,	which	might	impact	the	functionality	of	Arduino	IDE.	Arduino	IDE	is	now	able	to	more	gracefully	handle	such	errors.	Display	donation	links	on	Arduino	IDE	update	arduino/arduino-ide#2581	Arduino	IDE	is	a	cornerstone	of	the	Arduino	initiative.	The	IDE,	as	well	as	all	its	helper	tools	and	components,	are	free	open	source
software.	This	software	benefits	the	entire	Arduino	community,	even	those	who	do	not	use	the	boards	sold	by	Arduino.	The	ongoing	work	to	develop	and	maintain	this	software	can	be	supported	by	donating	to	Arduino.	The	IDE	now	displays	a	link	to	the	donation	page	during	updates	via	the	auto-updater,	and	on	the	first	start	after	an	update.	Fix
memory	leak	when	scanning	sketchbooks	with	large	folders	arduino/arduino-ide#2555,	arduino/arduino-ide#2537	Previously,	the	IDE	could	become	unresponsive	if	the	sketchbook	contained	a	folder	with	many/large	files.	Support	compilation	of	very	large	sketch	files	arduino/arduino-ide#2571,	arduino/arduino-cli#2729,	arduino/arduino-cli#2718
Previously,	compilation	would	fail	spuriously	if	any	sketch	code	file	was	larger	than	4	MB.	The	maximum	sketch	file	size	has	now	been	increased	to	16	MB.	(Thanks	@jacek_kander)	Store	all	temporary	files	in	path	indicated	by	build_cache.path	arduino/arduino-ide#2571,	arduino/arduino-cli#2673,	arduino/arduino-cli#2668	When	a	sketch	is	compiled,
Arduino	IDE	stores	the	generated	files	in	a	temporary	folder.	It	is	possible	to	configure	the	path	under	which	the	files	are	stored	via	Arduino	CLI's	build_cache.path	configuration	key.	This	capability	might	be	required	for	some	rare	advanced	use	cases.	Previously,	the	configuration	only	controlled	where	the	generated	Arduino	core	library	files	were
cached,	while	sketch	and	library	files	were	still	stored	in	the	default	location.	All	generated	files	are	now	stored	under	the	path	specified	by	the	build_cache.path	configuration	key	when	the	user	has	added	that	key	to	the	configuration	file.	Align	viewsWelcome	behavior	to	VS	Code	arduino/arduino-ide#2543	This	change	allows	Arduino	IDE	extension
developers	to	accomplish	certain	UI	designs.	(Thanks	@dankeboy36	and	@pjrc)	Expand	and	improve	translations	arduino/arduino-ide#2523,	arduino/arduino-ide#2571,	arduino/arduino-cli#2692,	arduino/arduino-cli#2757	The	community	work	to	make	Arduino	IDE	accessible	to	everyone	in	the	world	through	localization	of	the	text	of	the	IDE's	UI
continues,	reaching	high	coverage	levels	for	18	languages/locales.	If	you	would	like	to	contribute	to	the	Arduino	IDE	translations,	please	see	the	information	here:	Update	Arduino	CLI	dependency	to	1.1.1	arduino/arduino-ide#2571	Much	of	the	non-GUI	functionality	of	Arduino	IDE	comes	from	the	Arduino	CLI	tool.	In	order	to	benefit	from	the	ongoing
development	work	in	the	Arduino	CLI	project,	Arduino	IDE	has	been	updated	to	using	Arduino	CLI	version	1.1.1.	Full	changelog	here:	If	you	have	any	questions	or	feedback	please	post	here	in	the	dedicated	forum	category	for	Arduino	IDE	2.x:	If	you	want	to	see	the	list	of	known	issues,	work	in	progress,	submit	a	formal	report,	or	contribute	to
development,	the	Arduino	IDE	2.x	source	code	is	hosted	in	this	public	repository:	Im	using	arduino	IDE	2.3.2	with	esp32	wrrom	kit	and	Im	trying	to	generate	a	simple	pwm	example	and	Im	getting	this	error:	Compilation	error:	'ledcSetup'	was	not	declared	in	this	scope	The	esp32	library	is	the	3.0.4.	I	read	in	the	forum	abouyt	this	error	but	how	do	I
solve	it?	Thanks	Gaston	1	Like	Please	post	your	sketch,	using	code	tags	when	you	do.	This	prevents	parts	of	it	being	interpreted	as	HTML	coding	and	makes	it	easier	to	copy	for	examination	In	my	experience	the	easiest	way	to	tidy	up	the	code	and	add	the	code	tags	is	as	follows	Start	by	tidying	up	your	code	by	using	Tools/Auto	Format	in	the	IDE	to
make	it	easier	to	read.	Then	use	Edit/Copy	for	Forum	and	paste	what	was	copied	in	a	new	reply.	Code	tags	will	have	been	added	to	the	code	to	make	it	easy	to	read	in	the	forum	thus	making	it	easier	to	provide	help.	1	Like	GastonMelo:	this	error	Show	the	full	error.	did	you	#include	?	ledc	API	has	changed,	theres	no	ledcAttachPin	anymore	I	forgot	to
mention	that	this	is	a	new	installation	of	arduino	IDE	2.3,	I	already	installed	the	esp32	espresif.	So	I	need	to	install	other	libraries?¡	#include	#include	//	Define	LEDC	channel,	GPIO	pin,	and	resolution	#define	LEDC_CHANNEL	0	#define	LEDC_PIN	12	#define	LEDC_RESOLUTION	10	//	Set	resolution	to	10	bits	void	setup()	{	//	Initialize	LEDC	channel
ledcSetup(LEDC_CHANNEL,	50,	LEDC_RESOLUTION);	//	Set	frequency	to	50Hz,	resolution	to	10	bits	ledcAttachPin(LEDC_PIN,	LEDC_CHANNEL);	//	Associate	GPIO	pin	with	LEDC	channel	}	void	loop()	{	int	dutyCycle	=	(pow(2,	LEDC_RESOLUTION)	-	1)	*	0.075;	//	Calculate	duty	cycle	value	using	10-bit	resolution	ledcWrite(LEDC_CHANNEL,
dutyCycle);	//	Delay	for	1	second	delay(1000);	dutyCycle	=	(pow(2,	LEDC_RESOLUTION)	-	1)	*	0.0875;	//	Calculate	duty	cycle	value	using	10-bit	resolution	ledcWrite(LEDC_CHANNEL,	dutyCycle);	delay(1000);	dutyCycle	=	(pow(2,	LEDC_RESOLUTION)	-	1)	*	0.075;	//	Calculate	duty	cycle	value	using	10-bit	resolution	ledcWrite(LEDC_CHANNEL,
dutyCycle);	delay(1000);	dutyCycle	=	(pow(2,	LEDC_RESOLUTION)	-	1)	*	0.0625;	//	Calculate	duty	cycle	value	using	10-bit	resolution	ledcWrite(LEDC_CHANNEL,	dutyCycle);	delay(1000);	}	the	error	output	/home/gaston/Arduino/sketch_sep16b/sketch_sep16b.ino:9:5:	error:	'ledcSetup'	was	not	declared	in	this	scope	9	|	ledcSetup(LEDC_CHANNEL,
50,	LEDC_RESOLUTION);	//	Set	frequency	to	50Hz,	resolution	to	10	bits	|	^~~~~~~~~	/home/gaston/Arduino/sketch_sep16b/sketch_sep16b.ino:10:5:	error:	'ledcAttachPin'	was	not	declared	in	this	scope;	did	you	mean	'ledcAttach'?	10	|	ledcAttachPin(LEDC_PIN,	LEDC_CHANNEL);	//	Associate	GPIO	pin	with	LEDC	channel	|	^~~~~~~~~~~~~	|
ledcAttach	exit	status	1	Compilation	error:	'ledcSetup'	was	not	declared	in	this	scope	@ZX80	tried	to	point	you	to	the	Espressif	documents	that	explain	what	are	the	differences	between	version	2.x	and	3.x	of	the	ESP32	API.	On	3.x	version,	ledcSetup()	and	ledcAttachPin()	are	no	longer	available.	That	means	you	have	2	options:	Rollback	the	version	of
the	ESP32	board	to	the	version	2.x	OR	modify	your	code	according	to	the	new	API.	Since	the	code	is	nor	big	or	complex,	I	suggest	the	second	option.	void	setup()	{	ledcAttach(LEDC_PIN,	50,	LEDC_RESOLUTION);	}	and	all	ledcWrite	functions	thereafter	will	need	to	be:	ledcWrite(LEDC_PIN,	dutyCycle);	5	Likes	Maybe	try	this	version:	#define
LEDC_PIN	12	#define	LEDC_RESOLUTION	10	//	Set	resolution	to	10	bits	float	multiplyfactor[4]	=	{0.075,0.087,0.075,0.0625};	void	setup()	{	ledcAttach(LEDC_PIN,	50,	LEDC_RESOLUTION);	}	void	loop()	{	for	(int	i=0;	i	Registers	emulation:	“None(ATMEGA4809)”	since	the	beginning.	Recently	I	noticed	that	this	has	changed	back	to:	Registers
emulation:	“ATMEGA328”.	I	suspect	it	was	caused	by	this	update.	Hi	@stitech.	stitech:	I	suspect	it	was	caused	by	this	update.	The	regression	occurred	at	the	Arduino	IDE	2.3.0	release,	as	a	side	effect	of	this	bug	fix:	github.com/arduino/arduino-ide	###	Motivation	Store	the	board	config	data	per	sketch	and	not	per	IDE	install…	So	I	think	that	either
you	upgraded	from	Arduino	IDE	2.2.1	(or	earlier)	directly	to	2.3.2,	or	else	you	didn't	notice	the	regression	had	occurred	while	you	were	using	2.3.0	and	2.3.1.	I	don't	think	it	is	feasible	for	us	to	mitigate	the	regression	so	everyone	will	just	have	to	reset	their	custom	board	options.	My	most	recent	project	was	with	another	board,	so	that	change	may
have	gone	unnoticed	for	some	time.	Anyway:	thank	you.	Search	&	replace	-	great	feature,	to	see	preview	what	is	about	to	be	replaced.	1st	time	I	see	this	in	IDE	1	Like	Page	2	Arduino	IDE	2.3.2	works	great.	Tried	it	on	Raspberry	Pi	Pico	and	Espressif	ESP32S3.	Arduino	Nano	ESP32	ESP32-S3	on	order	will	test	that.	I	ran	two	different	processors	at	the
same	time!	I	didn’t	even	check	if	that	was	possible.	Great	work!	2	Likes	A	post	was	split	to	a	new	topic:	Problems	with	IDE	2.x	A	post	was	split	to	a	new	topic:	IDE	2.3.2	not	opening	Hi	-	I	am	using	2.3.2	Is	there	a	way	of	cancelling	a	verify	or	upload	after	it	has	started	yet?	I	have	seen	numerous	posts	about	it	coming	but	have	not	found	out	how	to	do	it
as	yet.	There	are	times	when	you	press	upload	or	verify	and	know	it	is	going	to	fail	but	you	just	have	to	wait	it	all	out	before	you	can	try	again.	Hopefully	the	function	is	in	the	IDE	now	and	someone	can	point	me	to	it.	Thanks	Do	not	know	about	2.3.2	but	with	the	nightly	2.3.3,	which	I	currently	use,	the	bottom	right	message	box	displays	a	Cancel
button	during	compile	and	upload.	It	works	as	advertised.	Ahhh...	Wonderful	-	thanks	-	will	look	at	the	nightlies.	Side	note:	I	am	running	the	nightly	builds.	In	fact	I	updated	today	on	general	principle	as	I	was	running	one	that	was	about	a	month	old.	However,	AFAIK	the	last	change	made	to	IDE	that	was	brought	into	the	nightly	builds	is	now
something	like	5	or	6	months	ago.	I	see	still	the	same	bug	as	described	for	2.0.2	here:	Often	stuck	on	uploading	(IDE	2.0.3)	IDE	2.x	Hi,	I'm	using	the	IDE	v2.0.3	with	a	Raspberry	Pi	Pico	W.	The	program	compiles	correctly,	it	starts	to	upload	the	compiled	program	but	most	of	the	time	the	popup	with	"upload	in	progress..."	(or	something	similar,	I	have
the	IDE	in	italian)	stays	forever	and	so	the	"upload"	button	is	disabled.	So	I	have	to	close	the	IDE	and	start	it	again.	Sometime	the	popup	(and	the	disabled	button)	stays	forever	even	if	the	program	is	uploaded	and	is	running.	Is	there	something	that	I	could	check?	Thank	y…	This	should	be	handled	properly.	Occasionally	happening	to	Pro	Micro:	A	post
was	split	to	a	new	topic:	Still	no	upload	without	recompile	A	post	was	split	to	a	new	topic:	Hay	alguna	guía	en	español?	This	topic	was	automatically	closed	180	days	after	the	last	reply.	New	replies	are	no	longer	allowed.

what	is	the	main	conflict	in	the	book	to	kill	a	mockingbird
yidabevi
zasopicu
vuxa
jerixifa
spanish	worksheets	for	high	school	pdf

https://global-product.org/CKEdit/upload/files/cef69b3a-5242-4781-952f-af99634279c2.pdf
http://dreamcatcherltd.com/userfiles/file/vepawodumoboba.pdf
https://samoinstitute.mn/uploads/assets/file/vifikob_kivufigekek_gewoditomab_somozup_winopewan.pdf
https://davideganlaw.com/images/edit_images/file/87a08b0d-1ccc-4f65-af2f-774695d68b8d.pdf
https://businesslife.com/content/file/fc9a4c95-514a-485f-8121-03715c1f5168.pdf
http://medicapoland.pl/uploaded/file/92737681247.pdf

